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Bienvenido a tu curso  
  
  
Revit Architecture intermedio  
   

Al terminar este curso conocerás el concepto de BIM y como la tecnología de Revit 

se enfoca en esta metodología y cómo Modelar edificios de formas básicas 

utilizando los elementos arquitectónicos incluidos en Revit.   
  

Podrás realizar modificaciones básicas a elementos arquitectónicos y adaptarlos a 

los requisitos de proyecto y modificar la estructura de los componentes básicos de 

un modelo arquitectónico.   

  

Preguntas frecuentes sobre nuestros Cursos Presenciales  

   

Preguntas frecuentes sobre nuestros Cursos Online   

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
https://youtu.be/jpGtRSkx8nE
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Derechos reservados  

© Todos los derechos reservados Darco©  

Todos los materiales contenidos en este sitio (incluyendo, pero no limitado a, texto, 

logotipos, contenido, imágenes [animadas y estáticas], iconos videos y fotografías, entre 

otros) están protegidos por las leyes de Derechos de Autor y Propiedad Industrial, tanto 

nacionales como internacionales.  

  

En relación con todo lo contenido en esta guía de estudio, se prohíbe la reproducción, uso, 

copia, impresión, distribución, publicación, traducción, adaptación, reordenación y cualquier 

otro uso o modificación total o parcial de los datos y obras contenidos en esta página, por 

cualquier medio y de cualquier forma.  

  

Para  cualquier  asunto  relacionado  con  este  aviso,  por  favor 

 contacte  a darco@darco.com.mx  

  

Aviso de Privacidad  

  

La privacidad de sus datos personales es de gran importancia para Darco por lo que 

hacemos de su conocimiento nuestro Aviso de Privacidad en www.darco.com.mx/privacidad  

  

Darco© es una marca registrada  

Autodesk© es una marca registrada￼   
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Capítulo 1  
  

Creación de vistas  
  

El manejo de vistas es esencial para documentar toda la información relacionada con el 

proyecto. La documentación de un proyecto en Revit se genera con vistas de: Corte, 

detalles, fachada, leyendas, listados de cuantificación y materiales, vistas de llamada, vistas 

3D, perspectivas y planos. Todos estos elementos que son guardados en vistas que 

contienen información específica del diseño principal, los cuales mantienen una 

sincronización en tiempo real en caso de que se realicen cambios.  

  

Las vistas de corte, fachada y detalles son 2D y estas se generan automáticamente a partir 

de la colocación de los símbolos de sección (section), elevación (Elevation) y llamada 

(callout) en una vista de planta, corte o fachada.   

  

  

La mayor parte de información del proyecto es guardada en vistas. Generalmente los 

cambios de propiedades realizados en una Vista no afectan a las demás. Pero si el modelo 

es cambiado en una vista en particular, los cambios serán visibles en todas las vistas del 

proyecto. Cada vez que una vista es generada está se listará en la ventana Project browser, 

desde la cual se puede navegar a través de todas las vistas del proyecto.  

  

Duplicado de vistas  
  

Las vistas pueden duplicarse usando tres métodos:   

  

Duplicado (Duplicate)  

  

Genera una copia de la vista que no incluye anotaciones (cotas, etiquetas, textos, notas 

clave etc.). Las propiedades (escala, niveles de detalle, estilos visuales) de una vista 

generada con esta opción pueden cambiarse, sin que estos cambios se vean reflejados en 

la vista original. En este tipo de vistas se puede agregar anotaciones sin que estas se vean 

reflejadas en la vista original. Los cambios en la geometría del modelo afectan a todas las 

vistas del proyecto.  
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Duplicado con detalle (Duplicate with Detailing)  

  

Genera una copia de la vista que incluye anotaciones (cotas, etiquetas, textos, notas clave 

etc.). Las propiedades (escala, niveles de detalle, estilos visuales) de una vista generada 

con esta opción pueden cambiarse, sin que estos cambios se vean reflejados en la vista 

original. En este tipo de vistas se puede agregar anotaciones sin que estas se vean 

reflejadas en la vista original. Los cambios en la geometría del modelo afectan a todas las 

vistas del proyecto.  

  
    

Duplicado con dependencia (Duplicate as a Dependent)   

  

Las copias, conocidas como vistas con dependencia, permanecerán sincronizadas con la 

vista principal y las demás vistas dependientes, de modo que cuando se realicen cambios 

en una vista (por ejemplo, anotaciones o modificaciones en la escala), se reflejarán en todas 

las demás. Puede crear vistas con dependencia para vistas de plano, alzado, sección y 

llamada.  

  

La creación de vistas dependientes puede resultar útil en los casos siguientes:   

  

• Si trabaja en un proyecto grande con una pletina de suelo extensa y desea recortar la 

vista en segmentos más pequeños para poder colocarlos en planos. Al realizar cambios 

en los segmentos dependientes de la vista, se podrá ver rápidamente el efecto que 

tienen en la vista en general consultando la vista principal.   

• En caso de que necesite colocar una vista en más de un plano.   

  

Las vistas dependientes se muestran en el Navegador de proyectos bajo la vista principal.   
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Para crear duplicados de vistas:  

  

1. En el Project Browser, hacer clic derecho sobre la vista que se requiere duplicar.  

2. En el submenú escoger opción Duplicate view.  

  

  
  

3. Escoger una opción de duplicado requerida.  

  

Para cambiar el nombre de una nueva vista:  

  

1. En el Project browser, hacer clic derecho sobre el nombre de la vista   

2. En el  submenú, escoger opción Rename…  

  

  
  

  

Plantillas de Vistas   
  

Una plantilla de vista es un conjunto de propiedades de vista, por ejemplo; escala de vista, 

disciplina, nivel de detalle y configuración de visibilidad. Utilice plantillas de vista para aplicar 

una configuración estándar a las vistas. Las plantillas de vista pueden ayudar a garantizar 

que se sigan las normas de la empresa y a conseguir la coherencia entre los conjuntos de 

documentos de construcción.   

  

Antes de crear plantillas de vista es conveniente plantearse cómo se utilizarán las vistas. 

En cada tipo de vista (plano de planta, elevación, alzado, sección, 3D etc). Puede crear una 

plantilla de vista para cada estilo con el fin de controlar la configuración de las 

modificaciones de visibilidad o gráficos de categorías, escalas de vista, niveles de detalle, 

opciones de visualización de gráficos, etc.  

  

  

Para crear una plantilla de vista:  

1. Escoger pestaña View => panel Graphics => desplegar icono  (View  

Templates) => opción   
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2. En el listado de plantillas escoger la plantilla de vista a usar como base.  

  
  

3. Hacer clic sobre el botón  (Duplicar)  

4. Asignar el nombre a la nueva plantilla.  

5. En la casilla Filtros Discipline filters y View type filter, escoger la disciplina y tipo de vista 

a usar como base.  

6. En la sección View Properties escoger escala de vista y nivel de detalle.  
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7. Hacer clic sobre el botón Edit que esta frente a la opción V/G Overrides Model.  

8. Definir los colores y grosores de línea para las categorías que se requieran cambiar.  

  

  
  

9. Presionar el botón Ok, para salir del cuadro de dialogo V/G Overrides Model.  

  

10. Nuevamente, en la sección View Properties de la caja de dialogo View Templates, definir 

el resto de las configuraciones que se necesiten.   

  

11. Presionar el botón OK, para salir y aceptar los cambios.  

  

Para aplicar una plantilla de vista:  

  

1. Activar la vista a la cual se quiere aplicar la plantilla.  

2. Escoger pestaña View => panel Graphics => desplegar icono  =>  opción  

  
3. En la caja de dialogo Apply View Template escoger la plantilla a aplicar.  

  

  
  

4. Presionar el botón OK, para salir del cuadro de dialogo Apply View Template.  

  

  

Vistas de Sección (Section)  
  

Las secciones o cortes se usan para ver la elevación del modelo a lo largo de un plano 

vertical específico. Las secciones pueden ser cortadas en segmentos, además pueden 

crearse secciones de referencia para vistas existentes.  
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En Revit una sección se representa con una “línea de sección”, la cual tiene asociada una vista 

llamada “Vista de sección”.  

  

Una sección genera un corte de los componentes interiores visibles del modelo a lo largo de 

la línea de sección.   

  

Para crear una Vista de corte:  

  

1. Activar la vista de planta correspondiente.  

2. Escoger Pestaña View => Panel Create => icono  (Section).  

3. Dibujar la línea de corte, especificando un punto inicial y un punto final.  

  

  
  

  

4. Para activar la vista de corte, hacer doble clic sobre la etiqueta de referencia de la línea 

de sección, o en el Project browser desplegar la sección Sections (Building Sections) 

y hacer doble click sobre la vista.  

  

   
Para cambiar el ancho y profundidad de una sección:  

  

1. Se puede cambiar el área que cubre una vista de corte, arrastrando las guías de la línea 

de corte.  
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Para dividir una línea de sección:  

  

La línea de sección puede cortar, para eliminar la visualización de cierta parte de la vista.   

  

1. Seleccionar la línea de sección, hacer clic sobre el símbolo  .  

2. Una vez cortada la línea se puede seleccionar los nodos de los extremos para ajustar el 

área de corte.  

  

  
  

Para cambiar la dirección de la sección:  

  

1. Seleccionar la línea de sección.   

2. Hacer clic sobre el símbolo flip Section.  

  

  
Segmentar vista de sección (Split Segment)  

  

La línea de sección puede dividirse para generar una trayectoria irregular. Puede segmentar una 

sección existente o una nueva.  

  

Para dividir una línea de sección:  

3.   Para el imi nar el   corte de la línea de secci ón hacer clic sobre el símbolo  .   
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1. Crear una vista de sección  

2. Seleccionar la línea de sección.  

3. En la pestaña contextual Modify Views => panel sections => escoger icono   (Split 
Segment).  

4. Hacer clic sobre la línea de sección, en el sitio a segmentar.  

  

  
  

5. Arrastrar el puntero en la dirección requerida.  

6. Hacer clic en el sitio donde colocará el nuevo segmento. La línea de sección se puede 

segmentar varias veces.  

  

  
    

Cambiar el símbolo de la línea de sección:  

  

1. Puede explorar las familias de símbolos de sección que trae Revit, las cuales se 

encuentran US Metric/Annotations.  
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• Los archivos de familia cuyo nombre comienza con M_Setion Head* son los 

que tienen la simbología para representar las vistas de sección.  

  

      
• Los archivos de familia cuyo nombre comienza con M_Section Tail* son los que 

tienen la geometría del símbolo que aparece en el otro extremo de la línea de 

sección.  

  

  
2. Para cambiar el símbolo de la sección, seleccionar la línea de sección.  

3. Ir a la paleta de Propiedades, abrir las propiedades de tipo.  

4. Bajo de grupo de parámetros Graphics, hacer clic sobre la casilla que esta frente a la 

opción Section Tag.  

  

  



16  

  

  

  
  

5. Se despliega la caja de dialogo de propiedades de tipo donde se muestran los parámetros 

que permiten cambiar el símbolo tanto el que va a la cabeza de la línea de sección como 

al otro extremo.  

  

  
  

6. Seleccionar los tipos de simbología a usar.  

7. Presionar el botón Ok, hasta salir de la paleta de propiedades.  

   

Vistas de Alzado (Elevation)  
  

Las vistas de alzado son parte de la plantilla de los proyectos, y facilitan la visualización del 

modelo desde una dirección específica. Las vistas de alzado por defecto que se crean en 

un proyecto son: north, south, east, y west.  

  

Las vistas de alzado muestran una vista horizontal del diseño desde cierto punto. Además, 

muestran; niveles, puertas, ventanas y todos los componentes del diseño.   
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Para crear una vista de alzado:  

  

1. Activar la vista de planta correspondiente.  

2. Escoger pestaña View => Panel Create => icono .  

3. Definir la ubicación de la etiqueta de alzado.  

  

  
  

   

4. Generalmente el símbolo de vista de alzado suele orientarse en dirección al muro más 

cercano. Al seleccionar el símbolo, muestra activado un recuadro  , que indica la 

orientación actual de la vista.  

  

  
  

5. Al seleccionar el símbolo de alzado, se observa que se puede girar usando la opción  

.  
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Plano de delimitación  

  

El símbolo de alzado a través del plano de delimitación permite cambiar la longitud que 

cubre la vista. Los puntos finales de los planos de delimitación se pueden ajustar 

arrastrando los controles azules.  

  

Para activar el plano de delimitación:  

  

1. Seleccionar la flecha del símbolo de alzado, para que se haga visible el plano de 

delimitación.  

  

  
  

2. Puede cambiar la profundidad y longitud de la línea del plano de delimitación, arrastrando 

las marcas que se encuentran a los extremos, o las guías que indican profundidad de la 

vista.   

  

  
  

  

3. Para activar la vista de alzado, hacer doble clic sobre la flecha del símbolo de alzado.  

4. Las vistas se elevación se generan bajo la sección Elevations en el Project Browser.  
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Opciones símbolo alzado  

  

El símbolo de alzado incluye casillas de verificación de opciones para crear vistas, como se 

muestra en la imagen siguiente.  

  

  
  

Para crear más de una vista de alzado a partir de un símbolo de alzado:  

  

1. Seleccionar el símbolo de alzado.  

  

  
  

2. Se despliegan en los cuadrantes del símbolo unos recuadros que están vacíos indican 

que no tienen una vista de elevación asociada en esa dirección.  

  

  
  

3. Activar el recuadro del lado en el cual necesite crear la vista de alzado.  
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Cuando una vista de alzado es creada, se mostrará el signo  en el cuadrante correspondiente.  

  

Para cambiar el simbolo de alzado:  

1. Escoger pestaña Insert => panel Load from Library => escoger icono   (Load 

Family)  

2. En  la  carpeta  de  libereías  correspondiente  por 

 ejemplo,  US  

Metric/Annotations  escoger en el listado cualquiera de la familias de simbolos 

de alzado. Los nombres de familias para símbología de alzado comienzan con 

el text “*_Elevation_Mark*”.  

  

 

(additional  

 Settings) =>    

4. En la caja de dialogo de propiedades de tipo, desplegar la casilla Elevation Mark y 

seleccionar el simbolo a usar  

  

  

3.   E scoger Pestaña Manage =>  Panel Settings =>   icon o  
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Indicadores de profundidad en vistas de sección y alzado  
  

Este comando puede aplicarse en vistas que se encuentren en disciplina arquitectónica y 

de coordinación. Esta característica de pantalla gráfica utiliza la presentación de gradiente 

para indicar los elementos que se encuentran más alejados y los elementos que están más 

cerca de la parte delantera de la vista. Esta función sólo aplica para las vistas de alzado y 

sección.  

  

Para Ubicación inicial/final, desplazar los controles Cerca y Lejos para especificar los límites 

del efecto de fundido. Los valores Cerca y Lejos representan un porcentaje de distancia 

desde la parte frontal (cerca) y posterior (lejos) de los planos delimitadores de vista.   

  

La profundidad se implementa fundiendo el color de fondo de los objetos al aumentar la 

distancia desde el visor. El rango de distancia en que se produce el fundido se controla 

mediante los controles deslizantes. Así:  

  

• El control deslizante Cerca (Near) (1):  Controla la distancia a la que empieza el 

fundido, todo lo que haya delante de esta distancia no se atenuará. Normalmente se 

mueve el control deslizante hasta la parte frontal y la mayoría de los elementos del 

modelo se muestran con total intensidad.   

  

• El control deslizante Lejos (Far) (2): Controla la distancia más allá de los elementos 

que se mostrarán en el porcentaje de Límite de fundido.   

  

• Límite de fundido (3): La vista comienza con total intensidad y se difumina hasta el 

porcentaje definido con el control deslizante   
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Para activar el indicador de profundidad:  

  

1. Crear una vista de alzado o sección, y activarla  

  

2. En la paleta de propiedades, bajo el grupo de parámetros Extensts en la casilla Far 

Clipping => hacer clic sobre botón Clip without line (opción por defecto)  
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3. En el cuadro de dialogo Far Clipping escoger activar la opción Clip without line  

  

  
  

4. En la barra de herramientas de controles de vista escoger icono Visual Styles => Opción 

Graphics Display Options.  

  

   
  

5. En el cuadro de dialogo Graphic Display Options desplegar la sección “Depth Cueing” y 

activar la opción Show Depth  
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6. Usando los controles de la barra Fade Start/End Location podrá modificar la profundidad.   

  

  
  

Si arrastra el control Near hacia el lado izquierdo, se modifica la distancia desde, el punto 

de inicio de la sección o alzado hacia atrás.  

  

  

    
  

Para modificar la intensidad del color (decoloración) de los objetos que están más lejos:  

  

1. Modificar los controles de la opción Fade Limit (%).  

  

Si el valor de la opción Fade Limit está en 0 los objetos que están más lejos se ven más 

claros o decolorados.  
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Si el valor de la opción Fade Limit es mayor que 0 los objetos que están más lejos 

comienzan a tener un color más intenso.  

  

    
  

2. Presionar el botón Ok para salir del cuadro de dialogo Graphic Display Options una vez 

terminadas las configuraciones.  

3. En la barra de herramientas de controles de vista puede activar la opción de Sombras.  

  

   
    

La instensidad de las sombras se ve afectada por el el porcentaje de decoloración 

definido en la opción Fade Limit.  
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Vistas de leyenda  
  

Las vistas de leyenda permiten crear leyendas donde se listan los componentes del edificio y 

anotaciones que se utilizan en el proyecto.  

  

Para crear una vista de leyenda:  

  

1. Escoger Pestaña View => Panel Create => desplegar icono  => opción  

 (Legend)  

2. En la caja de dialogo nueva vista de leyenda, definir la escala y nombre de la vista  

  

  
  

3. Presionar el botón OK.  
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Componentes de leyenda  

  

Una vista de leyenda puede incluir los siguientes componentes:  

  

• Leyenda de anotación. Muestra anotaciones de plano como los extremos de 

sección, los marcadores de nivel, las marcas de cotas de elevación, los símbolos de 

alzado, los símbolos de nota clave, las etiquetas de revisión, las etiquetas de 

elementos y otros símbolos que no representan objetos de modelo. Cada símbolo 

tiene un texto descriptivo asociado. Los símbolos se muestran en el tamaño de 

impresión.   

  

• Leyenda de símbolo de modelo. Muestra representaciones simbólicas de objetos 

de modelo con un texto descriptivo. Los elementos típicos incluyen equipos y 

elementos eléctricos, elementos sanitarios, equipos mecánicos y objetos de 

emplazamiento.   

  

• Leyenda de estilos de línea. Se usa para especificar el estilo de línea y texto que 

explica lo que representa dicho estilo en los dibujos. Algunos ejemplos son las líneas 

de clasificación para incendios, las líneas de propiedades, las líneas de retranqueo, 

el cableado eléctrico, los aparatos sanitarios y los ejes.   

  

• Leyenda de materiales. Muestra un ejemplo de patrón de corte o superficie, y un 

texto que identifica el material asociado a dicho patrón.   

• Proceso por fases. Muestra una sección de muro que se ha dibujado con una 

modificación de gráfico seleccionada, y un texto identificativo.   

  

Para agregar componentes de anotación a una vista de leyenda:  

1. Escoger pestaña Annotate => panel Detail =< desplegar icono   

(Component) => opción  (Legend Component)  

2. En la barra de herramientas de opciones desplegar la casilla Family para escoger la 

familia y tipo a representar en la leyenda  

  

  
  

3. En la barra de herramientas de opciones desplegar la casilla View y escoger el tipo de 

vista a usar para representar el elemento  
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4. Para completar la leyenda se puede colocar notas clave con las descripciones de los 

elementos  

  

  
  

Para documentar los componentes de leyendas se puede:  

  

• Añadir cotas a componentes de leyenda individuales para que sean más descriptivos. Sin 

embargo, no se pueden acotar componentes anfitriones, como los muros, techos y pisos. 

Tampoco se pueden acotar componentes de familia de sistema dentro de una leyenda.   

• Añadir claves descriptivas por materiales.  

• Añadir textos.  

  

Vistas de Detalle (Callouts)  
   

Cuando se crea un detalle directamente en el modelo se está utilizando la geometría real 

de Revit y se está aprovechando de las ventajas y capacidades paramétricas de Revit.  

Usar este método le permite maximizar la utilidad del modelo 3D   

  

Para crear un detalle en el modelo, se debe primero crear una vista callout en una vista en 

planta, alzado (Elevation) o corte (Sección), al hacer esto se puede entonces retomar 

elementos existentes, así como agregar nuevos componentes de detalle en la vista.  

  

Una vista de detalle selecciona un área de una planta o de un alzado y magnifica esa área.  

Se pueden poner vistas detalle en planos y serán numeradas automáticamente. Las vistas 

de detalle se comportan como cualquier otra vista en Revit.  A una vista de detalle se le 

puede continuar agregando componentes de modelo y símbolos de anotación.  

  

Para crear una vista de detalle (callout):  

1. Escoger la pestaña View => Create =>desplegar icono   => opción  

  
2. Señalar le región que quiere representarse, esa operación se puede realizar en las 

vistas de planta, corte o alzado. Cada vez que se cree una vista de detalle se genera 

una marca de referencia en la vista en que fue generada, así como su 

correspondiente vista en el Project browser.  
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3. Para abrir la vista de detalle, hacer doble clic sobre el símbolo de referencia.  

  

Componentes de detalle  

  

Los componentes de detalle son elementos 2D basados en líneas y pueden añadirse a 

vistas de detalle o a vistas de diseño. Solo son visibles en esas vistas. No cambian de 

escala con el plano, sino con el modelo.   

  

Los componentes de detalle no están asociados a los elementos de modelo que forman 

parte del modelo de construcción. En lugar de eso, proporcionan detalles de construcción 

u otra información en una vista específica.   

  

Para activar los componentes de detalle:  

  

1. Escoger pestaña Annotate => Panel Detail  

  

  
  

Se pueden crear vistas callout y utilizar componentes de detalle ya que estos conservan las 

capacidades paramétricas de Revit.    

  

Revit proporciona herramientas para asistir al usuario en la creación de los detalles:   

  

• Detail lines: Son utilizadas para dibujar elementos 2D con líneas.  

• Components: Estos componentes son elementos de detalle 2D,  son       visibles 

solamente en la vista en la cual se han colocado. Revit contiene alrededor de 500 familias 

de componentes de detalle, los cuales están organizados en carpetas de acuerdo a las 

16 divisiones establecidas por la CSI (Construction Specifications  

Institute).  

• Region: Son patrones de relleno para representar varias superficies como: concreto, 

tierra etc. Para crear estos patrones hay que dibujar las regiones en un plano de trabajo.  



30  

  

  

• Insulation: Crea un patrón de sombreado que representa el aislamiento en un detalle de 

pared    

• Revision clouds: Las nubes de la revisión se pueden dibujar para indicar las áreas de 

revisión, son un complemento del flujo de trabajo de revisión de planos.  

• Detail Group: permite colocar elementos de detalle que son parte de un grupo.  

  

Para agregar componentes de detalle:  

  

1. Activar la vista Callout (detalle) correspondiente  

2. Escoger pestaña Annotate => Panel Detail =>  icono   (Component)  

3. En la pestaña contextual Modify Place Detail Component => panel Mode =>  

escoger icono  (Load Family), para cargar familias de componentes.  

4. La carpeta “Detail items” contiene todas las familias de componentes de detalle 2D.  

  

   
5. Seleccionar el componente de detalle, cargarlo en el proyecto y colocarlo sobre la vista 

de detalle.  

  

  
  

Para crear una región con relleno:  

  



31  

  

  

1. Activar la vista de detalle correspondiente  

2. Escoger pestaña Annotate => Panel Detail => icono  (Region)  

3. En el panel Draw, escoger la herramienta para trazar el contorno de la región  

  

  
  

4. Dibujar un contorno cerrado, para definir el área de colocación del relleno  

  
  

5. Acceder a las propiedades de tipo.  

6. Bajo el grupo de parámetros Graphics, en las casillas:  

  

Foreground fill pattern: puede seleccionar un patrón de relleno que se mostrará en primer 

plano.  

  

Background fill pattern: puede seleccionar un patrón de relleno que se mostrará de fondo.  
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7. Presionar el botón Ok para aceptar los patrones seleccionados  

8. Para crear la región hacer clic sobre el icono   
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Detalles repetitivos  

  

Con la herramienta Detalle de repetición, se define un recorrido marcando el punto inicial y 

final, el recorrido designado coloca como un patrón de relleno (Hatch) el componente de 

detalle seleccionado en las propiedades de tipo.   

  

Para colocar un detalle repetitivo:  

  

1. Cargar la familia de componentes de detalle que se requiere usar como un detalle 

repetitivo  

2. Escoger pestaña Annonate => panel Detail => desplegar icono   

(Component) => escoger opción   

3. En la paleta de propiedades, en las propiedades de tipo desplegar la casilla Detail   

4. Seleccionar el detalle que se va a repetir  

  

|    

  

5. Desplegar la casilla Layout y escoger el formato para la colocación del detalle, que puede 

ser: Espaciado fijo, número de elementos, Máximo espaciado, llenar con espacio 

disponible  
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6. En la casilla Spacing, escribir el valor del espaciado o el número de elementos, según 

sea el caso.  

7. Definir el punto inicial y luego el punto final.  

  

  
Propiedades de una vista  

  

Las propiedades de una vista permiten controlar y modificar las siguientes funciones:  

  

Escala: permite ver la escala de la vista tal y como aparece en la hoja de dibujo. Para cambiar 

la escala de una vista, seleccione un valor de la escala de la lista.  

  

Para ver y cambiar el valor de escala de una vista:  

  

1. En la barra de herramientas de control escoger icono escala o también en la ventana de 

propiedades desplegar la casilla View Scale  
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En caso de que la escala a configurar no esté en el listado, escoger la opción Custom.   

  

Niveles de detalle: Aplica un nivel de detalle de ajuste a la escala de la vista: básico, medio, o 

fino. Este ajuste anula el ajuste automático de nivel de detalle para la vista.   

  

Cuando se aplica un nivel de detalle a una vista, se permite la visibilidad de determinadas formas 

de la geometría:   

  

• La estructura compuesta de muros, pisos, techos, en el nivel de detalle medio y fino.   

• Cambios en la familia dependiendo de la geometría de los niveles de detalle.  

   

• Los cambios estructurales dependiendo del nivel de detalle. En el nivel básico, aparece 

como líneas. En los niveles medio y fino, se muestra con más de geometría.   

  

   
Para cambiar un nivel de detalle:  

  

1. En la barra de herramientas de control, hacer clic sobre el icono Detail Level  

  
  

2. Escoger la opción, según el nivel de detalle a usar.  

  

Para asignar estilos de línea a las capas de elementos compuestos:  

  

1. Activar la vista de detalle correspondiente  

2. Activar el cuadro de dialogo Visibility Graphics   

3. En la sección Override Host Layers, activar la opción Cut Line Styles  

  

  
  

4. Presionar el botón Edit  

5. En el cuadro de dialogo Host Layer Line Styles, asignar grosor, color y patrón de línea.  
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Bajo la columna función se muestran las capas de que forman la estructura de; muros, techos, 

pisos, cubiertas y losas.  

  

6. Aceptar todos los cambios.  

  

Para asignar colores a otros componentes:  

  

1. Activar la vista de detalle correspondiente  

2. Activar el cuadro de dialogo Visibility Graphics  

3. En la pestaña Model Category desplegar la categoría a la cual se requiere cambian el 

estilo de línea  

4. Seleccionar el elemento de la categoría para cambiar el estilo y bajo la columna 

Projection/Surface, hacer clic en la opción Override  

  

  
  

5. En la caja de dialogo Line Graphics seleccionar las características para el estilo de línea  

  

  
  

6. Aceptar los cambios y salir del cuadro de dialogo Visibility Graphics  
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Drafting View  
   

Las vistas Drafting se utilizan para dibujar elementos o detalles adicionales que no son parte 

del modelo, estas vistas solo servirán referencia y no estarán ligadas al proyecto. En este 

tipo de vistas sólo podrá usar las herramientas de detalle y líneas modelo para dibujar.  

  

Para crear una vista Drafting:  

1. Escoger Pestaña View => Panel Create =>   

2. Utilizando las herramientas de detalle dibujar los elementos requeridos, o insertar 

archivos CAD, imágenes etc.  

  

Vistas 3D  
  

Se pueden crear vistas 3D desde las vistas de planta, elevación o sección. Existen dos tipos de 

vista 3D; Vista 3D paralelas y Vista de Cámara.  

  

  
  

Cuando una vista 3D paralela o de cámara está activa, se muestran las opciones de navegación 

3D, en la parte superior derecha de la vista.   

  

El ViewCube permite la visualización del diseño 3D desde diferentes puntos vista; frontales, 

laterales e isométricas.  
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Puede hacer clic sobre los vértices o caras del cubo, para combinar ángulos de visualización en 

vistas isométricas  

  

         
  

La herramienta Full Wheel Navigation, complementa las opciones para girar, realizar zoom, 

encuadre, y restituir las vistas anteriores a la actual (rewind) sobre las Vistas Default 3D.     

  

  
  

Vista 3D paralelas  

  

Son las vistas 3D por defecto, la visualización de estas vistas se controla a través del View Cube, 

y muestran todos los elementos de la vista a la misma distancia y tamaño.  

  

Para crear una vista 3D:  

1. Escoger Pestaña View => Panel Create =>   

2. Para usar las opciones del View Cube, hacer clic sobre cualquiera de las caras del cubo.  

  

   
3. En la rueda del View Cube, puede arrastrarse de forma interactiva para girar la vista.  

  

   
4. Para hacer Zoom, Encuadre y Orbita en tiempo real, activar el comando Full Navigation 

Wheel, desde la barra de herramientas de navegación.  
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Para cambiar el nombre de una vista 3D:  

  

1. Seleccionar la vista llamada 3D View, que está bajo la opción 3D View en el Project 

browser  

2. Hacer clic con el botón derecho sobre el nombre   

3. Escoger opción renombrar  

4. Escribir el nuevo nombre  

  

Para recortar vistas 3D:  

  

1. Activar la vista 3D  

2. En la paleta de propiedades en las propiedades de instancia, bajo el grupo de parámetros 

Extents activar la casilla que esta frente a la opción Section Box  

  

  
  

3. Se observa que se crea un cubo alrededor de los elementos que son visibles en la vista. 

Seleccionar el cubo. Cada cara del cubo muestra unas guías que al arrastrarlas en una 

dirección específica recortan la vista.  
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Box Selection (región de selección)  

  

Aísla el elemento seleccionado abriendo automáticamente una vista 3D, la cual muestra 

todos los elementos que tienen una representación en 3D en una región recortada alrededor 

del objeto.  

  

Para aislar un objeto y ver la representación en 3D:  

  

1. Seleccionar un objeto  

  

  
  

2. En la pestaña Contextual Modify => Panel View => opción  (Box Selection)  

3. Se abre una vista 3D que aisla el objeto seleccionado.  

  

  
  

Vistas de Cámara  

  

Las vistas de cámara permiten generar perspectivas del modelo 3D.  
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Para crear una vista de cámara:  

  

1. Activar una vista de planta  

2. Escoger pestaña View => panel Create => Desplegar icono  3D View =>  

opción   

3. En la barra de herramientas de opciones en la casilla Offset escribir la altura de la 

cámara y el nivel al cual estará referenciada.  

  

  
  

4. Definir en la vista donde se va a colocar la cámara  

  

  
  

5. Determinar hacia donde apunta el objetivo de la cámara y hacer clic en el sitio.  
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6. La vista de perspectiva se abrirá automáticamente. Puede ajustar el cuadro de visibilidad 

desplazando los nodos que se encuentran a cada lado del recuadro que indica el área 

de visualización de la vista.  

  
  

7. Las vistas de cámara se colocan en el navegador de proyectos bajo la sección 3D Views, 

por defecto se nombran como 3D View.  

  

  
  

Para modificar altura de la cámara y objetivo:  

  

1. Activar la vista de perspectiva.  
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2. En la paleta de propiedades, en las propiedades de instancia bajo el grupo de 

parámetros Camera están las opciones que permiten modificar, tanto la altura de la 

cámara como del objetivo.  

  

  
  

Despiece de vistas 3D  

  

Permite crear conjuntos de despiece del proyecto.  

  

Para crear un conjunto de despiece:  

  

1. Activar una vista 3D  

2. Seleccionar cualquier elemento de la vista   

3. En la pestaña contextual Modify => panel View => escoger icono   (Displace 

Elements).  

4. Se activa entonces el panel Displacement Set.  

  

  
  

Para agregar más elementos al conjunto de despiece:  

1. En el panel Displacement Set => escoger icono (Edit)  

2. En la barra de herramientas Edit Displacement Set, activar icono  (Add)  

3. Seleccionar los elementos adicionales que serán parte del despiece  
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5. Utiilizando el Gizmo que se muestra sobre el conjunto de selección de despiece, desplazar 

los elementos en la dirección requerida.  

  

   
Crear un path de despiece:  

  

El parth de despiece, permite mantener vinculado un elemento a otro a través de líneas que 

facilitan la visibilidad y dirección de los objetos en el ensamblaje.  

  

1. Generar un conjunto de despiece sobre uno o varios objetos y desplazar el conjunto de 

despiece.  

  

4.   Presionar   el bot ón    ( Finish) para termina r la selec ción .   
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2. En el panel Displacement Set => escoger icono  (Path)  

3. Hacer clic sobre el punto que se corresponde para la conexión con otros elementos.  

  

  
  

4. Preseionar la tecla Esc para salir del comando.  

  

  

  

Capítulo 2  
  

Control de visibilidad de gráficos  
  

Revit puede también controlar la visibilidad de categorías de los elementos por vista, usando 

el comando de Visibility/Graphics.  En un diseño complejo, el comando permite simplificar 

una vista exhibiendo solamente los componentes necesarios.    
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Filtros  

  

Los filtros permiten controlar la visibilidad de un grupo de elementos que pertenecen a una o 

diferentes categorías, pero que comparten propiedades en común.  

  

Para crear un filtro:  

  

1. Entrar al cuadro de dialogo Visibility Graphics y activar la pestaña Filters  

2. Presionar el botón Add  

3. Presionar el botón Edit/New…  

4. En la caja de dialogo Filters, bajo la columna Filters, presionar el botón  para crear un 

nombre para el filtro  
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5. Bajo la sección Cateogories, seleccionar las categorías a incluir en el grupo de elementos  

  

  
  

6. En la sección Filter Rules, definir la regla que utilizará para incluir los elementos en el 

filtro.  

  

  
    

• En la casilla 1 escoger la propiedar a buscar  

• En la casilla 2 escoger el operador lógico  

• En la casilla 3 escoger el valor a buscar  

  

7. Escoger entre los  operadores AND o OR, para agregar más condiciones en un mismo 

filtro.  

  

  
  

8. Presionar el botón Add Rule  
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9. Presionar el botón OK para crear el filtro.  

10. Preseionar el botón OK para que el filtro sea visible en la pestaña Filters en la caja de 

dialogo Visibility Graphics.  

11. Se puede cambiar las propiedades de color, grosor y tipo de línea del filtro.  

  

  
  

  

Asignación de propiedades a las categorías  

  

Por defecto la mayoría de las categorías en Revit están definidas de color negro, sin 

embargo, se puede personalizar el color de la categoría, ya sea por cada vista o todas las 

vistas. Esto se hace desde el cuadro de dialogo Visibility Graphics.  

  

Para asignar propiedades a categorías en todas las vistas del proyecto:  

  

1. Escoger pestaña View => panel Graphics => icono  ó, teclear VG  

2. Activar la pestaña Model Categories, presionar el botón   

3. Seleccionar la categoría que se requiere cambiar   

4. Cambiar el color, grosor y patrón de línea de la categoría  
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5. Presionar el botón OK.   

6. Los cambios realizados en la categoría se observaran en todas las vistas del proyecto.  

  

Para asignar propiedades a las categorías por vista:  

  

1. Colocar activa la vista en la cual se requiere cambiar las propiedades de los objetos por 

categoría  

2. Escoger pestaña View => panel Graphics => icono  ó, teclear VG  

3. Activar la pestaña Model Categories  

4. Seleccionar la categoria a cambiar en el listado de la columna Visibility.  

5. Bajo las columnas Lines, Patterns, Transparency hacer clic en el botón Override…  

  

   
6. Escoger color, grosor de línea y tipo de línea a usar bajo la columna Lines  

  

  
  

7. Bajo la columna Patters, escoger los patrones de relleno a usar para las categorías cómo 

pisos, losas, muros etc.  
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8. Bajo la columna transparencia, escoger el grado de transparencia para los objetos.  

  

  
  

9. Presionar el botón Ok, para aceptar los cambios.  

  

  

Configuraciones generales en Revit  
  

Antes de comenzar con el desarrollo del diseño, es necesario realizar las configuraciones que 

permitirán trabajar con los estándares de organización de la compañía.  

  

  
Creación de una plantilla (Template)  
  

Los proyectos nuevos se crean basados en formatos llamados “templates” los cuales contienen 

los estándares de diseño que se usan en una oficina BIM:  

  

Por ejemplo, en un archivo de plantilla Revit se pueden definir lo siguiente:  

  

• Información del proyecto, tal como nombre, número, dueño, dirección etc.  

• Configurar las propiedades de líneas tales cómo; estilos de línea, patrones de relleno 

y texturas para materiales, unidades de medida del proyecto, estilos de simbología etc.  

• Definir las familias de sistema que se planea usar, también puede duplicar y modificar 

las familias para personalizarlas de acuerdo con los requerimientos del proyecto.  

• Rótulos de planos y formatos de tamaño para las vistas de planos.  
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Para crear una plantilla:  

  

1. Escoger  menú  de  aplicaciones  =>opción     

 =>  

herramienta   

2. En la caja de dialogo New Project desplegar la casilla Témplate file  

3. Escoger la plantilla de proyecto a usar  

  

  
  

También puede presionar el botón Browse para escoger la plantilla base que usará.  

4. En la sección Create New escoger Project Template  

  

  
  

Un archivo de plantilla en Revit tiene extensión *.RTE. Los archivos de plantilla tienen  una 

interfaz igual a la de un archivo de proyecto.  

  

Una vez creado el archivo de plantilla, se deben definir las configuraciones básicas que se 

usaran para todos los proyectos.  

  

Configurar listado de plantillas   

  

Es posible especificar los archivos de plantilla que se usan con más frecuencia en una lista que 

se mostrará en la ventana New Project, bajo la sección Template file.  

  

Para configurar plantillas en el listado de plantillas:  

  

1. Desplegar el Menú de aplicaciones => escoger Options  

2. En el lado izquierdo de la caja de dialogo de opciones, seleccionar la opción File 

Locations  

3. Bajo la sección Project Template Files: hacer clic sobre el botón  (Add Value)  

4. Buscar y seleccionar la plantilla que se requiere agregar a los listados  
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Para eliminar de la plantilla de proyecto las familias que no se van a usar:  

  

1. Escoger pestaña Manage => Panel Settings => icono   

2. Para quitar la selección de los tipos, que por defecto estan seleccionados presionar el 

botón Check None.  

  

  
  

3. Desplegar las categorías y revisar familias y tipos que se quieren eliminar de la plantilla, 

activando el recuadro que se encuentra al lado izquierdo del nombre de la familia o tipo.  

  

  
  

4. Presionar el botón OK para purgar el archivo plantilla de proyecto.  

  

Configuraciones adicionales del Proyecto   
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Revit permite definir varios ajustes a los elementos según requisitos particulares del 

proyecto. Por ejemplo, se pueden definir; tipos de relleno, estilos de línea, tags de símbolos 

de vistas de elevación y detalles, cotas, materiales etc.   

  

Para acceder a las opciones de configuraciones de estilos:  

Escoger pestaña Manage => Panel Settings =>  (Additional Settings)  

  

 (Patrones de relleno) Los patrones de relleno controlan el aspecto de las  

superficies cuando aparecen íntegras o cortadas en el plano proyectado. Utilice la herramienta 

Patrones de relleno para crear o modificar patrones de diseño y de modelo.  

  

  
  

• Los patrones de modelo representan el aspecto real de un elemento en la 

construcción, por ejemplo, una hilada de ladrillos o los azulejos de un muro, y son 

constantes con relación al modelo. Eso significa que cambian de escala con el 

modelo. Así pues, cualquier modificación en la escala de la vista también afecta a 

las escalas de los patrones.  

  

• Los patrones de diseño representan materiales de forma simbólica; por ejemplo, la 

arena se representa mediante un patrón de punteado. La densidad de los patrones 

de diseño es constante con relación al plano de dibujo.   

  

Para cargar patrones de relleno a una plantilla o proyecto:  
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1. Abrir el archivo de plantilla o proyecto  

2. Escoger pestaña Manage => Panel Settings =>  (Additional Settings) =>  

  
3. En la caja de dialogo Patrones de Relleno, verificar que la opción Drafting en la sección 

Tipo de patrón este activada  

4. Presionar el botón New  

5. En la caja de dialogo Nuevo patrón asignar un nombre al patrón de relleno  

6. Presionar el botón Import para importar el patrón de relleno. Este debe estar definido en 

un archivo *.pat  

7. Definir la escala de importación del patrón de relleno.  

8. Aceptar los cambios hasta salir del cuadro de dialogo de creación de relleno  

  

  
  

NOTA: La escala asignada a un patrón de relleno en el momento de la importación no se puede 

cambiar.  
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Estilos de línea  

  

Los estilos de línea se utilizan para crear diferentes efectos, por ejemplo, una línea 

discontinua (------) para los planos de referencia. Cuando se instala y ejecuta Revit 

Architecture, se incluyen varios estilos de línea. Cada estilo de línea predefinido tiene un 

nombre que describe la línea en sí (por ejemplo, Trazo punto) o el lugar donde Revit 

Architecture utiliza el estilo de línea (por ejemplo, Líneas <boceto>). Revit Architecture 

almacena los estilos de línea en la plantilla predeterminada.  

  

En el editor de familias no se pueden crear estilos de líneas, pero sí modificar el grosor, color y 

patrón de las líneas.  

  

Para crear un estilo de línea:  

1. Escoger pestaña Manage => Panel Settings => Desplegar  => opción  

  
2. Presionar el botón New  

3. En la caja de dialogo New Subcategory, asignar un nombre al estilo de línea  

4. En el listado de estilos de línea, cambiar la configuración requerida en cuanto a color, 

grosor y patrón.  

  

  
  

  

Grosores de línea  

  

Puede controlar los grosores de línea para las líneas de modelo, perspectiva y anotación.   

  

En las líneas de modelo, se especifica el grosor de línea para componentes de modelo, 

como puertas, ventanas y muros, en vistas ortogonales. El grosor de línea depende de la 

escala de la vista.  

  

Para líneas de perspectiva, puede especificar grosores de línea para componentes de 

modelado en vistas de perspectiva. Se puede aplicar diferentes estilos y grosores de línea 

con la herramienta Tipo de línea. En las líneas de modelo, puede controlar el grosor de 

línea para objetos de anotación, como las líneas de sección y cota. Los grosores de los 

símbolos de anotación no dependen de la escala del diseño.  

  

Para definir grosores de línea:  
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1. Escoger pestaña Manage => Panel Settings => Desplegar  => opción  

  
2. Presionar el botón Add  

3. En la caja de dialogo Agregar escala, seleccionar el valor de la escala de vista que se 

requiere usar.  

  

  
  

4. Se agrega una columna con el valor de escala.  

  

  
  

5. Tomando como referencia los valores de 1 hasta 16, bajo la columna de escala, escribir 

el valor en milímetros del grosor de línea.  

  

  
  

Para asignar grosor de línea a una categoría de objeto:  
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1. Escoger pestaña Manage => panel Settings => icono   (Object Styles)  

2. Buscar la categoría requerida y cambiar el valor de grosor de línea bajo la columna Line 

Weight.  

  

   
Para asignar grosores de línea a una vista:  

  

1. Activar la vista a la cual se requiere asignar grosores de línea.  

2. En la barra de herramientas de estatus, seleccionar la escala de la vista.  

  

  
  

Al escoger la escala de la vista, se asignan los grosores de línea asignados en la columna 

escala en la caja de dialogo “Grosores de línea”.  

  

  

Simbología para vistas  

  

Las opciones; Los símbolos de llamada, Elevación, Sección, Flechas de líneas de cota y 

dimensiones temporales, permiten seleccionar la familia de anotaciones que se usará por 

defecto para símbolo de vistas de detalle, elevaciones, secciones, líneas de cota, además 

cambiar propiedades de tipo como el tamaño de las flechas de cota. Los símbolos de 

etiquetas están definidos en las familias de anotaciones.   
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Para asignar o cambiar los símbolos:  

  

1. Escoger pestaña File => Open => Family  

2. Abrir archivo de familia correspondiente en el editor de familias. las familias de simbología 

se encuentran en la carpeta Annotations, los nombres de archivos de familia identifican 

el tipo de símbolo que contienen. Por ejemplo, las familias que comienzan con los 

nombres: M_Section_Head, son familias de símbolos de secciones. M_Elevation, son 

familias de símbolos de elevaciones etc.  

  

  
  

  

3. Realizar los cambios requeridos y guardar los cambios.  

4. Abrir el archivo de proyecto o plantilla al cual se requiere cargar la familia.  

5. En el editor de familias, escoger Pestaña Create => Panel Family Editor =>  
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icono (Load into Project).  

6. Escoger Pestaña Manage => Panel Settings => icono  (additional Settings)  

7. Escoger cualquiera de las opciones de acuerdo al tipo de símbolo que se requiere 

cambiar.  

8. En las propiedades de tipo, desplegar la casilla donde se puede seleccionar el símbolo a 

usar.  

  

  
  

  

Información del proyecto  

  

En la caja de dialogo información del proyecto, se definen los datos generales relacionados con 

el proyecto como el nombre, número, cliente etc.  

  

Las vistas de plano pueden mostrar información del proyecto, configurando el rótulo con 

etiquetas que extraigan datos del proyecto y lo muestren en el plano.  

  

Para agregar información del proyecto:  

1. Escoger pestaña Manage => Panel Settings => icono  (Project information)  

2. Ingresar los datos del proyecto  
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Capítulo 3  
  

Listados de Cuantificación y Materiales  
  

Las tablas son consideradas como un tipo de vista en Revit, las tablas despliegan 

información que se extrae del proyecto, esta información es contenida en las propiedades 

de cada componente.  

  

La información que se despliega en las tablas es mostrada en forma de lista, pero se pueden 

generar criterios de despliegue lo que dará mayor versatilidad a las tablas, así por ejemplo 

podemos tener agrupados los elementos por piso, por tipo, por cuarto etc.  

  

Inmediatamente después que es creada una tabla, aparece su vista en pantalla, pero, además 

la vista es salvada en la lista del Project browser.  

  

Las tablas pueden crearse en cualquier momento del proceso de diseño del proyecto, y los 

cambios que esta sufra se verán reflejados inmediatamente. Las tablas pueden agregarse 

a un plano.  

  

Al momento de aceptar los parámetros de la tabla, se desplegará un listado, en el que se 

debe escoger los campos a contabilizar (anchos, alturas, materiales, costos, nombres, 
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familias etc.) los criterios de despliegue (si los objetos de despliegan por cuarto, por nivel 

por marca, por familia etc.), organización, así como el aspecto de tabla (tipo de texto, altura 

de campos etc.)  

  

Los listados ser exportados como archivos de texto o a una tabla de base de datos.  

  

Los tipos de listado que genera Revit son:  

  

• Listados de materiales: desglosan la estructura de elementos complejos tales como; 

muros, pisos, techos, losas etc. Estas tablas se llaman Material Takeoff  

• Listados de cuantificación: cuantifican componentes del modelo tales como puertas, 

ventanas, mobiliario, etc.  

• Listados de planos: genera un listado de planos  

  

Los parámetros a configurarse cuando se crear un listado son:  

  

Fields (Campos)  

  

En esta sección aparecerán todos los campos disponibles de acuerdo con la categoría 

seleccionada, es importante mencionar que en el orden en que se selecciones los campos, 

será el orden de despliegue final.   

  

Filter (Filtros)  

  

Permite crear filtros que limitan el despliegue de los datos en el listado, por ejemplo, se puede 

limitar el listado para que muestre la información de las puertas de un solo nivel.  

  

Sorting/Grouping (organizar y agrupar)  

  

Permite ordenar el listado agrupando de forma ascendente o descendente las filas de 

acuerdo con un criterio (campo). También incluye funciones que agrupan los datos 

colocándoles encabezados, títulos, y totales.  

  

Formatting (formato)  

  

Define el formato para los encabezados del listado, de los campos y activa la función de mostrar 

totales para los campos numéricos.  

  

La función de formato condicional permite crear un filtro de identificará de un color diferente 

aquellas celdas del listado que cumplan con una condición establecida.  

  

Appearance (apariencia)  

  

Establece la apariencia del listado en cuanto se refiere a estilos de texto y formatos de la tabla.  

  

Para crear un listado de cuantificación:  
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1. Escoger pestaña View => Panel Create => Desplegar icono  =>  

opción   

2. En la sección Category, escoger en el listado la categoría de la cual se va a generar el 

listado.  

3. En la casilla Name: asignar un nombre   

  

  
  

4. ¨Presionar el botón OK.  

5. Activar la pestaña Fields, En la sección Available Field: se debe hacer doble clic sobre 

los campos que se incluirán en el listado, o seleccionar el campo y hacer clic en la opción 

 para pasar los campos seleccionados a la sección Scheduled fields (in order)  
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6. Activar la pestaña Filter. Opcionalmente se puede definir un filtro para hacer una 

búsqueda más especifica.  

  

  
  

7. Activar la pestaña Sorting/ Grouping. Definir el campo que se usará para organizar el 

listado.   

  

8. Activar las opciones Header and Footer para agrupar los elementos del listado según 

los criterios de organización, e indicar las cantidades por cada grupo. La imagen muestra 

un ejemplo de agrupamientos cuando se activa la opción footer.  
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9. Al activar la casilla Grand totals, se despliegan al final del listado los totales generales 

del listado.  

  

  
  

10. Activar la pestaña Formating. En la casilla Heading escribir el nombre personalizado 

para el encabezado de la columna. En la casilla Heading orientation y Alignment escoger 

la orientación del texto del encabezado y la alineación del texto.  
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11. En la sección Field formatting: al desplegar la casilla No calculation, se puede escoger 

calcular valores cómo totales, promedios máximos y mínimos sobre los campos que son 

numéricos.  

  

  
  

12. Al presionar el botón Field format, se puede establecer un formato específico para los 

campos numéricos, cómo establecer un formato de moneda, la simbología de volúmenes, 

áreas etc.  

  

  
  

13. Presionar el botón Aceptar para generar el listado.  
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Para crear un listado de materiales:  

1. Escoger la pestaña View => Create => Schedule =>   

2. Escoger la categoría o categorías de elementos sobre los cuales se va a generar el 

listado.  

3. En la pestaña Fields escoger los campos a incluir en el listado.  
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Los campos que desglosan los materiales de un elemento compuesto comienzan con el 

nombre Material:  

  

4. Opcionalmente definir filtros en la pestaña Filter  

5. Organizar el listado configurando las opciones den la pestaña Sorting/Grouping  

6. Establecer nombres de encabezados y formatos  

7. Generar listado  
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Para crear listados de planos:  

1. Escoger la pestaña View => Create => Schedule => opción   

2. Seguir el procedimiento ya indicado para crear tablas de cunatificación.  

  

Personalización de formatos de tablas de cuantificación   
  

Existen varias modificaciones o propiedades que se pueden agregar a las tablas de 

cuantificación o materiales, a continuación, se describirán algunas de ellas:  

  

Insertar filas   

  

Es posible insertar filas en el área de títulos y encabezados en los listados de cuantificación. 

En el caso de los listados de planos se puede agregar un registro completo con los datos 

de planos que aún no han sido creados.  

  

Para insertar una fila en el área de títulos y encabezados:  

  

1. Activar la vista del listado de cuantificación  

2. Hacer clic sobre la celda del título (esto podrá el texto en modo de edición)  

3. Escoger pestaña Modify Schedule/Quantities => panel Rows => desplegar icono  

 (Insert)  

4. Escoger la opción correspondiente, dependiendo si se quiere insertar la fila arriba o abajo 

del título.  

  

  
    

Fusionar celdas  
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Es posible fusionar celdas que han sido insertadas en la sección del título del listado de 

cuantificación.  

  

Para fusionar celdas:  

  

1. Activar la vista del listado de cuantificación  

2. Seleccionar las celdas que se requieren fusionar en la sección del título del listado.  

3. Escoger pestaña Modify Schedule/Quantities => panel Titles & Headers =>  

escoger icono  (Merge Unmerge)  

  

  
  

Editar tablas de cuantificaciones  

  

1. Activar la vista desde el Project Browser en la sección Schedules/Quantities (all)  

  

  
  

2. En la paleta de propiedades, en las propiedades de Instancia, bajo los parámetros 

llamados Others, hacer clic sobre el botón Edit, que este frente a cualquiera de las 

opciones de configuración del listado.  
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3. Se desplegará la caja de dialogo de configuraciones del listado, activar la pestaña a 

modificar y realizar los cambios correspondientes.  

  

Campos con formatos condicionales en listados de cuantificación  

  

Es posible asignar un formato condicional a los valores del listado que cumplan con una 

condición específica, asignando un color.  

  

Para crear un formato condicional:  

  

1. Activar la vista que contiene el listado a modificar.  

2. Entrar a las propiedades, bajo el grupo de parámetros otro, hacer clic en el botón Edit, 

frente a la opción Formating.  

3. Seleccionar el campo que mostrará un color diferente en el listado  

4. Hacer clic sobre el botón Conditional Format  

  

  
  

5. En la casilla Field, escoger un campo sobre el cual establecer la condición  

6. En la casilla Test, seleccionar el operador lógico.  
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7. En la casilla Value, escribir el valor que deben cumplir los elementos   

8. Hacer clic sobre el recuadro Background color para escoger el color del cual se pintarán 

los datos que cumplan con la condición.  

  

  
  

9. Aceptar los cambios y salir del modo de edición  

  

  
  

Adjuntar imágenes a los registros en listados de cuantificación  

  

Es posible agregar imágenes por cada registro de un listado de cuantificación de manera 

individual.  

  

Agregar imágenes a los registros en listados de cuantificaciones y materiales:  

  

1. Crear o editar un listado de cuantificación o materiales  

2. En la pestaña Fields en el listado de campos disponibles buscar la opción  

“Image”  

  

  
  

3. Seleccionar los campos adicionales que quiera incluir en el listado.  



72  

  

  

4. Una vez generado el listado de cuantificación o materiales, bajo la Columna Imagen hacer 

clic sobre la casilla donde se quiere agregar la imagen.  

  

  
5. En el cuadro de dialogo Manage Images presionar botón Add  

6. Buscar y seleccionar la imagen a utilizar en el listado, presionar el botón OK.  

  

El listado de cuantificación no despliega la imagen, solo la ruta de donde se ha cargado.  

  

  
  

  

Para visualizar las imágenes de un listado de cuantificación:  

  

1. Crear una vista de plano  

2. Arrastrar y soltar el listado de cuantificación o materiales sobre la vista de plano.  
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Asignar colores a celdas de la sección del titulo y encabezado de columnas:  

  

Para asignar colores a celdas:  

  

1. Seleccionar la celda o celdas  

2. Escoger pestaña Modify Schedule/Quantities => panel Appearance => escoger  

icono  (Shading)  

3. En la paleta de colores, escoger los colores a asignar  

  

  
  

  

Insertar imágenes en la sección del título del listado  

  

Para insertar una imagen en la sección del título de la tabla de listado:  

  

1. Hacer clic sobre la celda donde se colocará la imagen  

2. Escoger pestaña Modify Schedule/Quantities => panel Titles & Headers =>  

icono Insert Image  

3. Seleccionar la imagen a cargar y escoger botón Abrir  
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Formulas en listados  
  

En los listados de cuantificación y materiales se puede incluir columnas que contengan 

fórmulas. A través de estas fórmulas se podrá calcular valores que completen la información 

relacionada con precios de volúmenes, áreas etc.  

  

Para crear una columna que contenga una fórmula:  

  

1. En la caja de dialogo “Schedule Properties” activar la pestaña Fields  

2. Escoger presionar el botón   

3. En la caja de dialogo Calcular valores, en la casilla Name, escribir el nombre de la 

columna como va a aparecer en la tabla de cuantificaciones.  

4. En la opción Type, desplegar la casilla y escoger el valor, según el dato a calcular. En la 

imagen a continuación, se observar que el valor seleccionado en Volume, porque el dato 

que se quiere obtener es el calculo de costo por volumen.  

5. En la casilla Formula definir la fórmula seleccionando los datos a calcular.   
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Capítulo 4  

  

Documentar vistas  
  

Revit cuenta con un set de herramientas de anotación especializado para documentar y 

detallar vistas y planos, a través de cotas, textos, etiquetas, tags, elementos de despiece, 

espacios y áreas.  

  
Dimensiones (Cotas)  
  

Las dimensiones son los elementos de vista que muestran tamaños y distancias en un 

proyecto. Hay dos tipos de dimensiones: temporal y permanente. Revit pone dimensiones 

temporales mientras se colocan los componentes en el proyecto.  Las dimensiones 

permanentes son utilizadas para definir un tamaño o una distancia particular. Cualquiera de 

los dos tipos de dimensiones se puede modificar y el componente al que son referidas es 

actualizado, por consiguiente.  

  

Dimensiones Temporales  

  

Las cotas temporales se activan cada vez que una instancia es seleccionada, al quitar la 

selección, las costas temporales desaparecen. Las cotas temporales están referenciadas 

directamente a los muros y ejes más cercanos al objeto seleccionado, en el caso de puertas 

y ventanas se pueden configurar las cotas temporales para que se muestren referenciadas 

al centro o ancho de puertas y ventanas.  
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Las cotas temporales pueden convertirse en cotas permanentes de tal forma que se pueda 

establecer restricciones sobre los objetos a los cuales están relacionadas.  

  

Para configurar la justificación de las cotas temporales sobre muros:  

1. Escoger pestaña Manage=> panel Settings => desplegar icono  => opción  

  
2. En la caja de dialogo de propiedades de dimensiones temporales en la sección Walls 

escoger el tipo de justificación sobre los muros.  

3. En la sección Doors and Windows escoger la justificación sobre puertas y ventanas.  

  

  
  

Para convertir una cota temporal en permanente:  

  

1. Seleccionar un objeto.  

2. Al activarse la cota temporal, hacer clic sobre el símbolo que se despliega bajo el valor 

de la cota temporal.  
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Para crear una restricción sobre una cota:  

  

1. Seleccionar la cota.  

2. Hacer clic sobre el símbolo de candado  que se muestra por debajo de la cota   

  

  

  

  

  

  
  

3. Cuando el símbolo de candado se ve cerrado   significa que la restricción está 

establecida.  

  

Para cambiar la línea de referencia de una cota temporal sobre un objeto:  

  

1. Seleccionar el objeto.  

2. Cuando se muestra la cota temporal, ubicar el cursor sobre el nodo de la línea de 

referencia que se quiere cambiar en la cota.  
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3. Arrastrar el cursor sobre la nueva referencia en el objeto y hacer clic sobre el objeto, 

entonces la cota temporal cambiará los valores correspondientes.  

  

  
  

    

Dimensiones permanentes  
  

Una dimensión permanente se fija en un lugar específico. La dimensión es creada cuando 

se selecciona el icono azul de dimensionamiento que aparece al seleccionar un 

componente o al crear la dimensión con el comando de dimensionamiento. Las 

dimensiones permanentes pueden aparecer de dos formas: modificable y no modificable.  

  

Una dimensión permanente se considera modificable cuando la geometría a la que se 

refiere se selecciona para su modificación. Cuando esto ocurre el texto que aparece está 

listo para modificarse.    

  

Una dimensión se considera no modificable, cuando esta ha sido creada con los comandos 

de dimensionamiento, aunque la dimensión sea no modificable esta mantiene su relación 

con el componente al que es referenciado, esto es sí, el componente se modifica la cota se 

actualizara de manera automática.  

  

Tipos de cota  

  

Las cotas son familias de sistema, se pueden crear nuevos tipos de cotas basados en los estilos 

ya existentes.  Los elementos que componen una cota se indican a continuación:  

  



79  

  

  

   
Para crear tipos de cotas:  

  

1. Escoger pestaña Annotate => panel Dimension => hacer clic sobre la flecha desplegable 

en el panel Dimension.  

  

  
  

2. Al desplegarse el panel, se muestran las opciones de tipos de cota que se pueden 

personalizar.  

  

  
  

3. Escoger la opción de tipo de cota a personalizar, se desplegará la paleta de propiedades 

de tipo. Los parámetros para configurar pueden variar dependiendo del tipo de cota, si 

es lineal, radial o spot.  

    

Los principales parámetros de gráfico para cotas lineales permiten definir:   
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• Tipo de flecha de la línea de cota ( Tick Mark)  

• Longitud de la línea de extensión (Witness Line lenght)  

• Extensión de la línea de extensión (Witness Line extension)  

• Visualización de líneas de extensión (Witness Line control), tiene dos 

opciones:  

▪ Fixed to dimensión line, desactiva la visualización de las líneas 

de extensión, o controla la longitud de las líneas de extensión, se 

debe modificar el valor en la casilla Witness Line lenght.  

▪ Gap to Element, controla la distancia entre la línea de extensión 

y el objeto acotado. se deben modificar los valores de la casilla 

Witness Line Gap to Element.  

  

▪ Color de la cota (Color)  

  

  
  

  

Los principales parámetros de grafico para cotas radiales, o diametros permiten definir:  

  

• Marca de centro (Center Mark): para identificar el centro de la circunferencia  

• Tamaño de la marca de centro (Center Mark Size)  

• Simobolo de Radio o diametro  
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Los principales parámetros de texto permiten definir:  

  

• Tamaño del texto de cota (Text Size)  

• Ubicación del texto sobre la línea de cota (Read Convention) •  Estilo de texto  

• Unidades alternas para acotar un mismo elemento con dos unidades de 

medida diferentes (Alternate Units)  

• Colocación del valor de altura en puertas, ventanas y huecos (Show Opening 

Height)  

  

   
4. Presionar el botón Ok para salir de la paleta de propiedades y guardar los cambios.  

  

Las opciones para crear cotas son: Alineada, lineal, angular, radial, punto de elevación, punto de 

coordenada y punto de ángulo.  

  

 Cotas alineadas (Acotando muros)  

  

Cuando se coloca una dimensión permanente en un muro se puede especificar, la 

justificación de la cota, las intersecciones con otros muros, además de huecos dejados por 

puertas, ventanas y huecos de muro.  
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Para crear cotas sobre muros:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Aligned)  

2. En la casilla Place Dimensions: seleccionar la justificación de la línea de cota sobre el 

muro (por ejemplo, al centro, o caras del muro).  

  

  
  

3. En la casilla Pick: se puede escoger dos opciones:  

  

• Individual reference: para definir la ubicación del punto final de la cota sobre el 

objeto.  

• Entire wall: para acotar el muro completo  

  

4. Al escoger la opción Entire wall, se activa el botón Options, que permite especificar los 

elementos que podrán referenciarse en la cota de muro.  

  

  
  

Cuando se activa la opción Openings en el cuadro de dialogo Auto dimensión 

Options; se agregarán líneas de cota sobre los huecos del muro (incluye huecos 

dejados por puertas y ventanas). La opción Centers, genera la línea de cota, hacia 

el centro del hueco, y la opción widths genera líneas de cota sobre el ancho del 

hueco.  
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La opción Intersecting Walls; genera cotas sobre las intersecciones del muro.  

  

  
  

  La opción Intersecting Grids; agrega líneas de cota sobre ejes  

  

    
    

5. Escoger las opciones de cota requeridas y presionar el botón OK.  

6. Colocar la cota sobre el muro.  

  

Cotas igualitarias  

  

Las cotas igualitarias son cotas alineadas consecutivas que permiten establecer una distancia 

igualitaria entre objetos.  

  

Para crear cotas igualitarias:  

  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Aligned)  

2. En la barra de herramientas de opciones, en la casilla Pick, escoger opción Referencias 

individuales.  

3. Según el elemento a acotar (pueden ser muros, puertas, o ventanas) en la justificación 

escoger Wall centerline.  

4. Colocar la cota de forma continua sobre los ejes de muro, centro de puertas o ventanas.  
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5. Una vez definidos todos los elementos, hacer clic en el sitio donde se colocarán las cotas.  

6. Seleccionar la cota igualitaria  

  
  

7. Para convertir la cota alineada en igualitaria, es decir que los elementos se distribuyan 

de forma equitativa de acuerdo a las referencias indicadas previamente, Hacer clic sobre 

el símbolo    

  

  
  

8. Para mostrar en el texto de las cotas, los valores de las distancias, se debe seleccionar 

la cota.  

9. En la paleta de propiedades, en las propiedades de instancia, bajo el grupo de parámetros 

Others, en la casilla Equality Display, escoger opción Value  

  

   
Formulas en cotas  
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Las fórmulas son una alternativa de etiquetas en las cotas, estas solo aplican sobre cotas 

consecutivas igualitarias. El objetivo de mostrar la etiqueta con una fórmula es dar una idea 

clara del criterio aplicado para establecer la distancia de los espacios.   

  

Para crear una etiqueta de fórmula en una cota:  

  

1. Crear la cota igualitaria.  

2. Seleccionar la cota y entrar a las propiedades de tipo  

3. Bajo el grupo de parámetros Other, hacer clic sobre el botón que esta frente a la opción 

Equality Formula  

  

  
  

En la caja de dialogo Formula igualitaria para cotas, en el listado de parámetros de 

dimensión, escoger los parámetros de acuerdo a lo que se quiere mostrar en la 

etiqueta. Por ejemplo, en la imagen a continuación la cota continua está dividida en 

4 segmentos que generan espacios iguales de 5.95 m de longitud cada espacio, el 

total de longitud desde el primer muro hasta el último es de 23.80.  

  

  
  

4. En la caja de dialogo de fórmulas igualitarias para generar la fórmula seleccionar los 

parámetros en un orden especifico   

  

   
  Donde:  

  

  Number of Segment: es la cantidad de segmentos de la cota continua  

Length of Segment: es la longitud de cada cota que forma parte de la cota continua.  

Total Length: es la longitud total de la cota continua  
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5. Bajo las columnas Prefix o Suffix, debe colocar el valor de los prefijos o sufijos que se 

requiere que acompañen a cada valor de la formula.  

  

6. Para activar la visibilidad de la etiqueta con la formula, manteniendo seleccionada la 

cota, en las propiedades de instancia, bajo el grupo de parámetros Other, desplegar la 

casilla Equality Display y escoger opción Equality Formula.  

  

  
  

Cotas lineales  

  

Las cotas lineales son horizontales o verticales (orientación ortogonal ) y miden la distancia entre 

dos puntos de referencia.  

  

Para crear cotas lineales:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Linear)  

2. Escoger el tipo de cota en las propiedades de tipo  

3. Hacer clic sobre el primer punto de rerencia en un objeto  

4. Hacer clic sobre el segundo punto de referencia en un objeto  

5. Hacer clic donde va a ubicar la cota  

      



87  

  

  

    
Cotas angulares  

  

Las dimensiones angulares se pueden colocar en puntos de referencia múltiples que comparten 

una intersección común.  

  

Para colocar una cota angular:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Angular)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre un punto sobre el primer elemento.  

  

  
  

4. Hacer clic sobre el segundo punto del elemento que comparte un punto en común con el 

primer elemento seleccionado.  

  

  
  

5. Hacer clic en el sitio donde se va a colocar la cota  
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Cota Radial  

  

Coloca una cota de radio sobre un arco o circulo.  

  

Para colocar una cota radial:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Radial)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre el arco o circulo a acotar  

  

  
4. Hacer clic en el sitio donde se va a colocar la cota  

  

Cota de diámetro  

  

Coloca una cota de diámetro sobre un arco o circulo.  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Diameter)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre el arco o circulo a acotar  

4. Hacer clic en el sitio donde se va a colocar la cota  
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Cotas de longitud de arco  

  

Puede sacar las dimensiones de los muros curvos, obteniendo la longitud total de la pared.  

  

Para crear una cota de longitud de arco:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Arc Length)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre el arco a acotar  

4. Seleccionar la referencia con la que se intercepta el primer extremo del arco  

5. Seleccionar la referencia con la que se intercepta el segundo extremo del arco  

6. Hacer clic en el sitio donde se va a colocar la cota  

  

  
      

Spot Elevation  

  

Coloca la cota de elevación actual del punto seleccionado. Las cotas de elevación también 

pueden mostrar la elevación de la parte superior y / o inferior de los elementos con un 

espesor.  

  

Para colocar una cota Spot Elevation:  
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1. Escoger pestaña Annotate => Panel Dimension => icono  (Spot Elevation)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre el elemento a acotar  

4. Luego especificar la ubicación de la flecha directriz  

5. Y por último la ubicación de la cota de elevación  

  

  
  

Spot Coordinate  

  

Coloca la cota de la coordenada actual del punto seleccionado.  

  

Para colocar una cota Spot Coordinate:  

1. Escoger pestaña Annotate => Panel Dimension => icono  (Spot Coordinate)  

2. Seleccionar el tipo de cota  

3. Hacer clic sobre el elemento a acotar  

4. Luego especificar la ubicación de la flecha directriz  

5. Y por último la ubicación de la cota de coordenada  

  

  
  

  

Restricciones en cotas permanentes  

  

Las cotas permanentes por defecto no tienen restricciones, lo cual indica que se puede 

cambiar las dimensiones o distancias de los objetos asociados a la cota. Al crear una 

restricción sobre la cota, no se podrá modificar las dimensiones o distancias. Cuando el 

símbolo en forma de candado  se muestra cerrado significa que cota está restringida.  

  

Otro tipo de restricción en cotas, son las restricciones igualitarias (Equality Constraints), que 

definen distancias iguales entre las intersecciones de muros. El icono de restricciones 

igualitarias se muestra cómo cuando no existe restricción.  
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Para restringir una cota:  

  

1. Seleccionar una cota   

2. Hacer clic sobre el icono de candado   

  

  
    

Para crear una restricción igualitaria:  

  

1. Acotar el muro, usando la opción Intersección de muros  

  

  
  

2. Seleccionar la cota  

3. Hacer clic sobre el icono   
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Textos  
  

Los textos permiten colocar notas de texto en la vista actual. Se puede colocar líneas de 

texto simple o párrafos de texto completos numerados, con sangría, con líneas directrices, 

etc.  

  

Para crear un tipo de texto:  

  

1. Escoger pestaña Annotate => panel Text => clic sobre flecha    

2. En la paleta de propiedades de tipo renombrar o duplicar un estilo de texto existente.  

  

  
  

3. Definir las propiedades más importaes de tipo para el estilo de texto.  
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4. Con el valor en la casilla Leader/Border Offset se define la distancia entre el recuadro 

que rodea el texto y el texto.  

  
5. En la casilla Leader Arrowhead escoger el símbolo para la línea directriz.  

  

  
6. En las casilla Text font  escoger el tipo de fuente a usar.  

7. En la casilla Text Size, escribir el valor del tamaño del texto.  

8. Presionar el botón OK para aceptar los cambios.  

  

Para escribir un texto:  

  

1. Escoger pestaña Annotate => panel Text => icono   

2. En la paleta de propiedades, en el selector de tipos, escoger el estilo de texto a usar.  
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3. Se despliega la pestaña contextual Modify Place Text.  

  

  
  

1. En la pestaña contextual Modify Place Text => panel Leader => escoger cualquiera las 

opciones de colocación de texto  requeridas.  

  

  
  

2. En caso de que sea un parrafo de texto escoger la opción requerida según la orientación 

de la directriz con respecto al texto.  

  

  
  

3. En la pestaña contextual Modify Place Text => panel Alignment => escoger cualquiera las 

opciones de justificación para el texto: Top, center, left o right.  

  

  
  

4. Hacer clic sobre la vista en el sitio donde se va a colocar el texto.  

5. En la pestaña contextual Edit Text se despliegan las opciones disponibles asignar 

propiedades al texto, escoger las opciones requeridas  

  

   

6. Al escoger los iconos    se puede asigar al texto la presentación en 

letras negritas, italicas y subrrayado.  
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7. Los icono  permite aplicar subindice o superindice al texto seleccionado.  

  

 (Subindice)  

  

 (Superindice)  

  

8. Al activar el icono  el texto completo se escribirá en mayúsculas.  

  

9. Los iconos  permiten aplicar sangrías a los textos a la izquierda o derecha.  

10. Una vez configuradas las opciones a aplicar, escribir el texto.  

11. Presionar el botón  para terminar el comando.  

  

Para agregar líneas directrices a un texto:  

  

1. Seleccionar un texto ya existente.  

2. En la pestaña contextual Modify Text Notes => panel Leader => escoger cualquiera de 

las opciones de directrices mostradas, dependiendo de la dirección, lado y apariencia 

de la directriz requerida.  

  

  
  

Para agregar más de una línea directriz en un texto:  

  

1. Seleccionar el texto que ya tiene por lo menos una directriz  

2. En la pestaña contextual Modify Text Notes => panel Leader => escoger cualquiera de 

las opciones de directrices mostradas, dependiendo de la dirección, lado y apariencia 

de la directriz que se requiera.  

  

  
Para eliminar líneas directrices en un texto:  
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1. Seleccionar el texto que ya tiene por lo menos una directriz.  

2. En la pestaña contextual Modify Text Notes => panel Leader => escoger  

opción  (Remove Last Leader)  

  

Cada vez que haga clic sobre el icono las directrices se irán elíminando en orden desde la última 

creada.  

  

Para colocar párrafos de texto numerado:  

  

1. Escoger pestaña Annotate => panel Text => icono .  

2. En la paleta de propiedades escoger el tipo de texto a usar.  

3. En la pestaña contextual Modify Text Notes => panel Leader => escoger cualquiera de 

las opciones de colocación de texto.  

3. Hacer clic en el sitio donde se va a colocar el párrafo de texto  

4. En el panel Paraghaph escoger cualquiera de las opciones de numeración o viñeta para 

las líneas de texto.  

  

  
  

5. Escribir la primera línea de texto.  

6. Para pasar a la segunda línea de texto, presionar la tecla ENTER, las líneas se irán 

numerando de forma automática.  

  

  
  

7. Hacer clic en cualquier parte fuera del cuadro de texto, para terminar el comando.  

  

Para cambiar la justificación de un texto:  

  

1. Seleccionar el texto al cual se requiere cambiar la configuración de justificación  

2. En la pestaña contextual Modify Text Notes => panel Alignment => escoger cualquiera 

de las opciones de justificación del texto.  
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Notas Clave (Keynotes)  
  

Los keynotes son etiquetas cuyos valores están definidos en un archivo llamado 

Keynotes.txt, las notas clave se usan para asignar códigos y descripciones de materiales o 

elementos a los objetos en Revit.    

  

Los archivos de notas clave pueden ser personalizados. El formato del archivo debe cumplir las 

siguientes características:  

  

 •  Debe contener tres columnas:   

  

▪ Código:  contiene el código de material o elemento  

▪ Descripción: contiene la descripción completa del material o elemento  

▪ Código de relación: contiene el código de relación con una categoría de material 

o elemento.  

  

Para crear un archivo de Notas clave:  

  

Los archivos de nota clave pueden ser creados en Microsoft Excel, y luego deben ser guardados 

como “Texto delimitado por tabulaciones” con extensión TXT.  

  

1. Crear un archivo de Excel  

2. Utilizar las columnas A, B, C para definir los conceptos:   

  

▪ La columna A: debe tener el código del concepto.  

▪ La columna B: debe tener la descripción del concepto  

▪ La columna C: el código que relaciona el concepto a una categoría  

  

La imagen a continuación muestra una vista del archivo de Excel con el formato de los 

datos que debe incluir el archivo de notas clave.  

   

   
  

3. En Excel escoger opción Guardar cómo: TXT “Texto delimitado por tabulaciones” 4. 

Asignar un nombre al archivo TXT.  
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Para configurar un archivo de notas clave:  

  

1. Escoger pestaña Annotate => panel Tag => icono  => opción  

  
2. En el cuadro de dialogo de configuración de notas clave, seleccionar el archivo txt que 

contiene los conceptos.  

3. En la sección File path escoger la opción requerida para localizar el archivo txt.  

  

   
4. Presionar el botón  Ok para aceptar los cambios.  

  

Asignación de notas clave a elementos  

  

Las notas clave se pueden asignar a los elementos ya sea por el tipo de elemento o por 

materiales. Las notas clave son de tres tipos:  

  

• Elemento: puede aplicarse a un elemento completo como, por ejemplo, un muro, un 

componente de detalle o una puerta.   

• Material: puede aplicarse a un material que se ha pintado en una superficie y a 

materiales asignados a las capas de componente de un elemento. Al asignar un 

valor de nota clave a un material, los objetos que usan ese material heredan el valor 

de nota clave.   

• Usuario: permite utilizar notas o expresiones de uso habitual para representar 

comentarios sobre documentación. Las notas de usuario adicionales deben añadirse 

a los archivos de texto de nota clave suministrados o incluirse en uno creado por el 

usuario.   

  

Para asignar un valor de nota clave a un elemento desde la paleta de propiedades:  

  

1. Seleccionar 

elemento.  



100  

  

  

2. En las propiedades 

de tipo 

clic en la casilla 

Keynote.  

  

  

  

 , bajo los parámetros Identity Data, hacer  

  

3. En el cuado de dialodo Keynotes, se muestra el listado de valores de notas clave  

  

   
4. Seleccionar el valor para el elemento.  

5. Presionar Ok, para salir de la paleta de propiedades.  

  

  

Para asignar un valor de nota clave a una capa en un objeto compuesto (pisos, muros, etc.):  

  

1. Seleccionar elemento.  
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2. En las propiedades de tipo  , bajo los parámetros Construction, hacer clic 

sobre el botón que esta frente a la casilla Structure.  

3. Seleccionar una capa del listado y hacer clic en la casilla para realizar asignación de 

material.  

  

  
  

  

4. En el cuadro de dialogo de materiales, escoger pestaña Identity  

5. En la sección Annotation Information, hacer clic sobre la casilla Keynote 6. En el 

cuado de dialodo Keynotes, se muestra el listado de valores de notas clave  

7. Seleccionar el valor para el material.  
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Para colocar la etiqueta de nota clave sobre un elemento:   

1. Escoger pestaña Annotate => panel Tag => desplegar icono  => opción  

  
2. En la paleta de propiedades, en el selector de tipos, escoger el formato de etiqueta.  
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En la familia de etiqueta de nota clave configurada por defecto en Revit, puede 

escoger colocar sólo el código o la descripción.  

  

3. Ubicar el puntero sobre el elemento a etiquetar, luego definir el punto de inicio de la 

directriz, y hacer dos veces clic sobre el sitio donde será colocada la etiqueta  

  

  
  

Para colocar una nota clave sobre una capa de un elemento compuesto:   

1. Escoger pestaña Annotate => panel Tag => desplegar icono  => opción  

  
2. Hacer click sobre la capa del elemento compuesto a etiquetar.   

  

  

  
3. Definir la ubicación de la etiqueta.  

  

Trabajo con Tags    
  

Los tags son etiquetas informativas que están vinculadas a los elementos modelo del 

proyecto. A todos los elementos modelo es posible colocarles un tag. Los tags son 

anotaciones que se definen en familias cargables, además se puede configurar un tag por 

defecto que esté vinculado a un elemento modelo.   

  

En algunos elementos como puertas y ventanas, es posible colocar automáticamente los 

tags a través de la opción Tag on placement, generalmente en el caso de las puertas sirven 

para numerar las instancias, los tags muestran el valor de la marca (MARK), que por defecto 

comienza la numeración en 1 y se incrementa automáticamente en 1. En las ventanas los 

tags, están configurados para identificar las ventanas por tipo desplegando en la vista el 

valor correspondiente a la propiedad del tipo de marca (TYPE MARK).  

  

Asignar tags a una categoría  
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Los tags se asignan por categorías de elementos, es posible asignar varios tags a una sola 

categoría.  

  

Para asignar tags a las categorías de elementos:  

  

1. Escoger pestaña Annotate => panel Tag => desplegar panel Tag  => opción  

  
2. En el cuadro de dialogo hacer clic sobre el botón Load Family  

3. Buscar las familias de tags disponibles en las librerías de Revit, las familias de Tags 

están en la carpeta Annotations y el nombre de la familia incluye la palabra Tag.  

  

  
  

4. Presionar el botón Aceptar para cargar el Tag. Revit asignará directamente el tag 

sobre la categoría a la que corresponde, bajo la columna Loaded Tags.  

  

  
  

Asignar tags a objetos  

  

Los tags pueden asignarse seleccionando cada instancia de forma individual o por 

categorías.  
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Para colocar un tag sobre una instancia:  

1. Escoger pestaña Annotate => panel Tag => icono  (Tag by Category)  

2. En la barra de herramientas de opciones, se muestran las opciones de colocación.   

  

Cuando la opción Leader esta activada, se despliega junto al tag una directriz que 

señala el objeto con el cual está relacionado el tag.  

  

   
3. Hacer clic sobre el elemento.  

  

  
  

Para colocar tags seleccionando categorías de objetos:  

  

1. Escoger pestaña Annotate => panel Tag => icono  (Tag All)  

2. En el cuadro de dialogo Tag All, activar el recuadro que está al lado izquierdo de la 

categoría.  
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• Al activar la opción All objects in current view, se etiquetan todos los elementos 

que están en la vista que pertenecen a las categorías seleccionadas.  

• Al activar la opción Leader, se mostrarán las directrices con la etiqueta del tag  

  

  

Colocación automática del tag en el momento de insertar un objeto:  

  

Estas instrucciones sólo aplican para objetos que tienen la opción de colocar los tags de 

forma automática, por ejemplo, puertas y ventanas.  

  

1. Al ejecutar el comando Door o Window, en la pestaña contextual Modify – Place  

Door o Modify – Place Window, en el panel Tag => activar icono  (Tag on 

Placement)  

2. Colocar el objeto en la vista.  

  

Modificar contenido del tag  

  

Las etiquetas de los tags pueden modificarse para cambiar la información que muestran en 

la vista, para esto se debe editar el archivo de familia.  

  

Para cambiar o añadir la información que aparece en un Tag:  
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1. Seleccionar el Tag  

2. En la pestaña Contextual Modify Tags => panel Mode => presionar icono   

(Edit Family)  

3. En el editor de familias, seleccionar la etiqueta (Label)   

4. En la pestaña contextual Modify – Label => panel Label => escoger icono  (Edit 

Label)  

5. En la caja de dialogo Labels en el listado de categorias de parámetros, se muestra 

el listado de los campos adicionales que puede agregar o por los cuales puede 

cambiar el valor actual del Tag.  

  

  
  

6. Para añadir etiquetas, deben seleccionarse en el listado y luego hacer clic en el  

botón  (Add parameters to Label).  

7. Puede agregar un prefijo o sufijo para complementar la información que aparecerá 

en pantalla.  

8. Activar la casilla Breark para que los datos salgan en diferentes líneas.  

  

  
  

9. En la paleta de propiedades de tipo, ajustar el tamaño de texto de las etiquetas.  

10. Guardar los cambios en la familia y cargarla nuevamente al proyecto  
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11. Tras el mensaje que solicita actualizar la definición actual de la familia de tag, 

escoger la opción aceptar.  

  

  
  

Tags y cotas en vistas 3D  

  

Puede colocar tags y cotas en vistas 3D, pero antes será necesario que la vista sea 

bloqueada. Cuando se desbloque la vista 3D y se cambia el punto de vista, las cotas y tags 

que hayan sido colocados se perderán.  

  

Preparar una vista 3D para colocar tags y cotas:  

  

1. Abrir o crear una vista 3D y definir el punto de vista que se requiera usar para colocar 

tags o cotas, usando las herramientas de navegación.  

2. En la barra de herramientas de controles de vista, hacer clic sobre el icono  

(unlocked 3D View) y luego la opción Save Orientation and Lock View.  
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3. Asignar un nombre a la vista 3D.  

4. Escoger pestaña Architecture => panel Work Plane => icono  (Set)  

5. Escoger la opción a usar para determinar el plano de trabajo a configurar y presionar 

OK.  

  

  
  

6. Escoger la cara de un objeto que tenga la orientación correcta, según el plano en el 

cual se requiera colocar la cota o tag.  

7. Agregar Tags y cotas, sin cambiar la orientación de la vista. Puede ejecutar los 

comandos Zoom y Pan.  

  

  
  

  
Rooms y áreas  
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Son subdivisiones de espacios basados en elementos tales como muros, techos y losas. 

Los espacios son elementos de construcción que se ajustan a los límites generados por 

puertas, muros y ventanas, tomando en cuenta que deben existir 3 o más muros.   

  

Una vez generados los espacios, se podrá generar un reporte de espacios que incluye 

áreas, volumen, materiales y nombre de espacios.  

  

Los espacios pueden ser visualizados en un esquema de colores, que permite observar 

gráficamente en el diseño, la utilización de las áreas del edificio.  

  

  
  

Los pasos a seguir para crear espacios en un proyecto son:  

  

• Definir un esquema de colores que incluye; nombres y colores de espacios y áreas  

• Crear los rooms o áreas en una vista 2D • Asignar nombres   

• Crear leyenda.  

• Generar un listado de cuantificación de espacios  

  

  

Para definir el esquema de colores:  

  

1. Escoger pestaña Architecture => Desplegar panel Room & Areas => opción  

  
2. En la caja de dialogo que definición del esquema de colores, Bajo Categoría, escoger 

la opción que se usara para nombrar los espacios. Las categorías creadas por 

defecto son Nombre y departamento.  
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3. Presionar el botón Add Value  para definir los nombres de los espacios  

4. Asignar un nombre al espacio  

5. Asignar colores y patrones de relleno  

  

  
  

  

Crear Rooms  

  

Los rooms pueden crearse uno a uno o de forma automática-  

  

Para crear rooms:  

  

1. Activar una vista de planta o corte.  

2. Escoger pestaña Architecture => Panel Room & Area => icono   

3. En la barra de herramientas de opciones en la casilla Upper Limit: definir el nivel 

límite superior para el room.  

4. En la casilla Offset, escribir la altura del espacio.  

  

  
  

5. En la paleta de propiedades, desplegar el selector de tipos y escoger el tipo de 

etiqueta para el room.  

  

  
  

6. Ubicar el puntero sobre el área a la cual se asignará el room y hacer clic dentro del 

área. (Revit detecta el área cerrada automáticamente).  
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7. Seleccionar el room (él área de room se pinta de color azul), en las propiedades de 

instancia bajo el grupo de parámetros Idetity data, en la casilla Name, escoger el 

nombre para el room.  

  

  
  

  

Para crear rooms detectados automáticamente:  

  

1. Activar la vista de planta o corte  

2. Escoger pestaña Architecture => Panel Room & Area => icono   

3. En la barra de herramientas de opciones determinar el nivel límite del espacio y la 

altura del espacio.  

  

  

  

4. Desplegar el selector de tipos y escoger el tipo de etiqueta para el room.  

  

  

5. En el panel Room escoger icono ( Place Rooms Automatically)  
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6. Una vez creados los rooms se mostrará un cuadro de dialogo indicando la cantidad 

de rooms que fueron creados  

  

  
  

Dividir Rooms  

  

Es posible subdividir los rooms existentes utilizando las herramientas para crear líneas de 

separación.  

  

Para dividir rooms:  

  

1. Identificar el room a dividir  

  

  

2. Escoger pestaña Architecture => Panel Room & Area => desplegar icono  => 

opción  (Room separator)  

3. En el panel Draw se muestran las opciones para dibujar las línea de separación  

4. Dibujar una línea entre muros para dividir el espacio de acuerdo a los requerimientos 

de diseño.  
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Colocar tag en un room:  

  

1. Escoger pestaña Architecture => Panel Room & Area => desplegar icono Tag  

Room  

  

  
  

2. Escoger Tag Room para colocar etiqueta a un room por vez  

3. Hacer clic sobre el room a etiquetar  
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4. Al escoger la opción  Tag All not Tagged, se despliega la caja de dialogo, etiquetar 

elementos no etiquetados.  

5. Activar el recuadro que se encuentra al lado izquierdo de la categoría Room Tags  

  

  
  

6. Presionar el botón Apply, y luego OK, para salir del cuadro de dialogo.  

    

  

Leyenda de espacios  

  

Crear leyenda de espacios:  

  

1. Activar vista una planta, corte o elevación.  

2. Escoger pestaña Analyze => panel Color Fill => icono  (Color fill legend)  

3. Hacer clic sobre la vista en el sitio donde se ubicará la leyenda  

4. En la casilla Space Type, escoger Rooms  

5. En la casilla Color scheme, escoger el esquema de colores a usar  
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6. Los rooms asumirán el color de acuerdo con los parámetros determinados en el 

esquema de colores  

  

  
  

Con esta asignación de colores se pueden generar planos de áreas o clasificaciones 

espaciales. Es importante mencionar que el relleno de colores en los rooms se realizará 

siempre y cuando tengan asignado un nombre, si además se requiere generar una 

clasificación por departamento, cada room deberá contener la información de a qué 

departamento pertenece.  

  

Áreas  
  

La herramienta de área, genera vistas de planta que indican el área de construcción y el 

área rentable, generando un contorno que está vinculado al paño interior de muros, en el 

caso de áreas rentables, y al paño exterior en caso de áreas de construcción.  

  

Para crear área rentable:  

  

1. Escoger pestaña Architecture => Panel Room & Area => Desplegar icono  

 => opción   (Area plan)  

2. En el cuadro de dialogo New Plan, en la casilla Type escoger Rentable.  
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3. En el listado de vistas de planta, seleccionar las vistas, para calcular el área rentable.  

  

  
  

4. El mensaje indica que se creará un borde que está vinculado a los muros exteriores 

del modelo, presionar el botón Sí.  

  

  
  

5. En el Project browser se creará una nueva sección llamada Area Plans, que es 

donde se almacenan todas las vistas de área  

  

  
  

Para colocar etiqueta de área:  

  

1. Escoger pestaña Architecture => Panel Room & Area => Desplegar icono  

  (Area)  

2. Hacer clic en el sitio donde se colocará la etiqueta dentro del área  

  

  =>  opción  
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Para calcular el área de construcción:  

  

1. Seguir el procedimiento ya indicado. El único cambio, es que en la caja de dialogo 

New Area plan, en la casilla Type escoger la opción Gross Building  
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Capítulo 5  
  

Trabajando con superficies topográficas  
  

Las funciones de topografía incluidas en Revit complementan la presentación de los 

modelos arquitectónicos, púes permiten referenciar el diseño con sus alrededores. Además, 

es posible crear regiones sobre las superficies topográficas para mostrar diferentes 

materiales y elementos de paisajismo.  

  

Origen de proyecto y terreno  

  

Cada proyecto tiene un punto base de proyecto  y un punto de terreno o suelo , los cuales 

por defecto son visibles en la vista Site. Estos puntos no pueden ser borrados.  

  

  
  

El punto base del proyecto define el origen (coordenadas 0,0,0) del sistema de coordenadas 

del proyecto. Este puede ser usado para posicionar el edificio sobre un terreno. Los 

símbolos de coordenadas y elevación que se colocan en las vistas de planta están 

referenciados al sistema de coordenadas de este punto.  

  

El punto de terreno representa un punto conocido en el planeta, es decir es una coordenada 

geográfica. El punto de terreno es usado para orientar correctamente la geometría en otro 

sistema de coordenadas, tales como los sistemas de coordenadas usados por los 

ingenieros civiles.   

  

Mover punto base de proyecto y punto de terreno  

  

Los puntos base de proyecto y terreno pueden estar bloqueados  o desbloqueados . 

Por defecto estos estan bloqueados.   

  

Cuando se mueve el punto del proyecto mientras esta bloqueado, se cambia la ubicación 

del proyecto, es decir los elementos modelo se reubican siguiendo la nueva coordenada del 

punto de proyecto.   

  

Cuando mueve el punto de terreno mientras esta desbloqueado, se asigna el punto de 

terreno relativo a las coordenadas de la geometria del modelo arquitectónico y al sistema 

de coordenadas del proyecto.  
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Para mover el punto de proyecto:  

  

1. Activar la vista de planta Site  

2. Puede colocar un símbolo de coordenada para comprobar la coordenada actual del 

punto de proyecto  

  
  

3. Seleccionar el punto base de proyecto   

4. En las etiquetas que muestran las coordenadas actuales. Hacer clic sobre el valor 

actual de las etiquetas N/S y E/W y asignar las coordenas.  

   
  

Para mover el punto de terreno:  

  

1. Activar la planta Site.  

2. Seleccionar el punto base de terreno.  

3. Desbloquear el punto de terreno.  

  

  
    

  

El norte verdadero del proyecto se puede manipular. Esto permitirá obtener una visión real 

de la ubicación y orientación del edificio con respecto al terreno sobre el cual será 

construido.  

  

Para asignar el norte real a un proyecto:  

  

1. Seleccionar el punto base del proyecto.  

2. Editar el ángulo para asignar el norte verdadero sobre la etiqueta “Angle to True 

North”     
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Nota: Si las coordenadas compartidas NO están habilitadas con un archivo vinculado:   

• Un movimiento de la ubicación de la base del proyecto en el proyecto Revit moverá 

el archivo enlazado.   

• No se hacen cambios en el archivo enlazado en sí pero el punto base del proyecto 

se actualizará para reflejar las nuevas coordenadas.  

  

Si las coordenadas compartidas están habilitadas con un archivo enlazado:   

• Un movimiento a la ubicación del punto base del proyecto en el proyecto de Revit no 

moverá el archivo enlazado.   

• En lugar de ello se actualizarán las coordenadas del punto base en el proyecto para 

reflejar las coordenadas compartidas.   

• Cada vez que se cambie el punto base del proyecto de Revit, las coordenadas se 

seguirán actualizando, cuando el proyecto se cierra o se guarda se solicitará que 

vuelva a guardar las coordenadas actualizadas en el archivo enlazado.  

  

Superficies Topográficas  
  

Una superficie topográfica se crea a partir de puntos colocados que tienen una elevación 

específica. Usando las herramientas de Revit Architecture se puede editar, agregar o 

eliminar puntos, además cambiar la elevación de los puntos, cortar la superficie y aplicar 

materiales.  

  

Una superficie consiste en un área de terreno sobre el cual objetos tales como árboles, 

estacionamientos, caminos, y edificios son colocados. Se puede controlar la visualización 

de los elementos sobre la superficie, creando configuraciones para el despliegue de los 

elementos, también se pueden manejar fases para mostrar los cambios que han sufrido las 

superficies durante el desarrollo del proyecto.  

  

Una superficie puede ser creada de dos formas, a partir de instancias importadas 3D y 

archivos de puntos.  

  

Importando un archivo de puntos  

  

Se puede generar de forma automática una superficie de terreno importando archivos de 

texto de formato TXT o CSV. Estos archivos deben contener los datos de las coordenadas 

X, Y Z como valores numéricos y la delimitación de espacios debe ser con comas.  
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Instancias importadas  

  

Usando polylíneas 3D de un archivo importado DWG, DXF o DGN se pueden generar 

puntos en Revit, para generar una superficie. Las elevaciones de la superficie serán 

determinadas en base a la elevación de los contornos.  

  

Para insertar archivos:  

  

1. En el Project Browser, bajo Floor plans, activar la vista Site  

2. No modificar la ubicación del punto de terreno ni de proyecto  

3. Definir las unidades de medida del proyecto   

4. Escoger pestaña Insert =>panel Link => icono   (Link CAD)  

5. Escoger las opciones de importación  

  

• En las unidades de importación debe especificar las unidades de medida a 

utilizar.  

• En la casilla Positioning: escoger la opción Auto – By shared Coordinates  

• En la casilla Place At escoger el nivel 1  

  

   
6. Presionar el botón Open.  

7. El mensaje que se indica a continuación, indica que las coordenadas del archivo 

importando no están compartidas, presionar el botón Cerrar.  
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8. Una vez importado el archivo, este se muestra referenciado a las coordenadas 

establecidas para punto de terreno y proyecto.  

  

  
  

Compartir coordenadas del proyecto  

  

Cuando se publican coordenadas compartidas de un proyecto anfitrión en uno vinculado, el 
modelo vinculado se actualiza con las coordenadas nuevas.  
  

Para compartir coordenadas de archivo vinculado a un proyecto de Revit:  

  

1. Primero se debe vincular el archivo en la vista Site.  

2. Escoger pestaña Manage => panel Project Location => desplegar icono  

Coordinates => opción .  

3. Hacer clic sobre el archivo importado  

4. En la caja Location, seleccionar la opción Internal en la sección Select the position  
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5. Presionar el botón OK.  

  

Para cambiar el nombre del sitio asignado a un archivo:  

  

1. Seleccionar el archivo importado.  

2. En las propiedades de instancia bajo el grupo de parámetros Other, hacer clic en el 

botón Internal que esta frente a la casilla Shared Site.  

  

Cuando la ubicación del archivo NO ha sido compartida el dato mostrado en el botón 

es .  

  

3. Escoger la opción Record current position as.  
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4. Presionar el botón Change…  

5. La opción seleccionada por defecto en la pestaña Site es DefaultLocation, presionar 

el botón Rename o Duplicate para cambiar el nombre de la ubicación.  

6. Asignar un nombre nuevo a la ubicación.  

  

  
  

7. Presionar el botón Aceptar, hasta salir del cuadro de dialogo Choose site.  

  

Determinar altura del proyecto  

  

Se puede determinar la elevación del terreno, sin afectar la altura de los niveles del proyecto 

arquitectónico, así, el nivel 1 seguirá estando a una altura de 0.  

  

Para determinar la altura del proyecto y del terreno:  

  

1. Abrir una vista de Elevación y activar la visibilidad del punto de terreno y proyecto.  

  

  



126  

  

  

  
  

2. Modificar la elevación del punto de terreno.  

  

  
  

3. Modificar la elevación del punto de proyecto.   

  

  
  

  

Al modificar la elevación del proyecto, deberá observar que la elevación de los 

niveles originales no haya cambiado  

  

4. Seleccionar el archivo importado.  

5. En las propiedades de instancia en la casilla Base Level seleccionar el nivel 

asociado, debe ser el nivel 1.  

6. En la casilla Base offset ingresar el valor de elevación.  
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Crear una topografía  

  

Para crear una topografía basada en un archivo DWG vinculado:  

  

1. Escoger la pestaña Massing & Site => Panel Model Site => desplegar icono  

(Toposolid)  

2. Escoger opción   (Create from Import)  

3. En el panel Toposolid escoger icono   (Create from CAD)  

4. Hacer clic sobre el archivo importado en la vista Site.  

5. En el listado, seleccionar las capas que se usaran como base para crear la 

superficie.  

  

  
  

6. Presionar el botón OK.  

7. Al activar una vista 3D, se observa la superficie generada.  

  

  
  

Control de visualización de las superficies  

  

La visualización de los elementos de la superficie puede ser controlada en una vista en 

particular, esto permite manipular elementos como; puntos de bordes, puntos interiores, 

curvas de nivel principales, curvas de nivel secundarias y ejes de triangulación.  

  

Para definir la visualización de los elementos de una superficie topográfica:  

  

1. Activar el cuadro de dialogo Visibility/Graphics (VG)  
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2. En la pestaña Model Categories, buscar la categoría Topography  

  

  
    

Puede asignar materiales y profundidad para la superficie topográfica. Estos valores son 

usados en las vistas de elevación y secciones. También se puede configurar los intervalos 

e incrementos entre las curvas de nivel mayores y menores.  

   
  

Para hacer un ajuste de los intervalos de las curvas de nivel mayores y menores: 

 

1. Seleccionar la superficie y acceder a las propiedades de tipo  

2. Frente al parámetro Comtour Display hacer click en el botón Edit 

 

 
 

3. Bajo la columna Interval, escribir la distancia de intervalos entre curvas de nivel 

primarias y secundarias. 
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4. Presiona el botón Ok para aplicar los cambios sobre las curvas de nivel. 

 

Para ver o ajustar los materiales de la topografía: 

 

5. Frente al Parámetro Structure => presionar el botón Edit 

 

 
 

 

Dividir superficies  

  

Una superficie topográfica puede dividirse en varias superficies más pequeñas y luego 

editar cada superficie de forma independiente. Al dividir una superficie puede ser necesario 

editar los bordes para asegurarse que las líneas de bosquejo no coincidan con el borde de 

la otra superficie.  

  

Las superficies se dividen a través del trazado de bosquejos. Si el bosquejo está formando 

un área cerrada, este no puede tocar ninguno de los bordes de la superficie. En caso de 

que el boceto quede abierto ambos extremos de la línea que define el boceto deben tocar 
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el borde de la superficie. Adicionalmente, los bocetos abiertos no pueden coincidir con el 

borde la superficie.  

  

Después que una superficie es cortada se le puede asignar diferentes materiales a cada 

nueva superficie generada.   

  

Para dividir superficies:  

  

1. Activar el nivel Site, donde se encuentra creada la superficie y seleccionarla 

2. Escoger pestaña Modify Toposolid  => Panel Toposolid Shaping => icono 

 (Su-Divide)  

3. Seleccionar la superficie topográfica que se quiere dividir.  

4. Usando las herramientas del panel Draw, definir el área de la superficie que se 

requiere dividir.  

  

  

5. Escoger pestaña Modify-Split Surface => Panel Mode => icono  (Finish edit 

Mode).  
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Nivelaciones (Graded Regions)  

  

Se puede crear una superficie nueva a partir de una existente. Usando Graden Regions se 

puede mantener la superficie original y escoger para editar sólo los puntos requeridos en la 

nueva superficie. Esta función es muy útil para definir zonas de estacionamiento, por 

ejemplo.  

  

Se puede obtener cálculos de volumen de corte y relleno, restando la superficie original con 

la superficie obtenida con Grade Region, también reportar el valor de volúmenes de relleno 

y corte cuando el terreno sea modificado.  

  

Los terraplenes son creados sobre fases. Cuando las superficies son creadas, se asignan 

automáticamente a demolición en la fase actual, y una copia exactamente igual es creada. 

Cuando la copia es editada esta es marcada dentro de la fase New Construction in la fase 

actual. Entonces en vez de borrar la superficie original, podrá usar un filtro de fases para 

ocultar la superficie.  

  

Para crear un terraplén:  

  

1. Escoger pestaña Massing & site => Panel Modify site =>  (Graded 
Region)  

2. Se despliega la caja de dialogo indicando las condiciones para la creación de la 

nueva superficie.  

  

• Al escoger la primera opción (1) (Create a new toposurface exactly like the 

existing one), la copia creada será exactamente igual a la superficie principal.  

  

• Al escoger la segunda opción (2) (Create a new toposurface base on  the 

perimeter points only) se creara una superficie basada en los puntos que forman 

el perímetro de la superficie principal.  
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3. Seleccionar la topografía.  

  

Al escoger la primera opción (1):  

  

4. Seleccionar los puntos a los que se requiere cambiar la elevación para crear la nueva 

superficie.  

5. Ingresar el nuevo valor de elevación.  

 

 
   

6. Presionar tecla enter una vez ingresada la elevación. 
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Al escoger la primera opción (2):  

  

7. Después de seleccionar la topografía, sólo los puntos de los bordes de la superficie 

quedan activos y las líneas de triangulación 

8. Definir la elevación de los puntos, para la nueva topografía  

 

 
  

  

9. Presionar la tecla Enter para aceptar los cambios.  

  

  

Edición de topografías 

 

Editar una topografía es prácticamente igual que modificar un piso, se posible ajustar el contorno, 

agregar líneas y puntos, las opciones para este procedimiento se encuentran en el panel Shape 

Editing. 
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Puede usar la herramienta de modificar subelementos para manipular una o más puntos o ejes 

sobre el piso. Puede agregar nodos y asignarles una elevación específica. 

 

Para agregar líneas de división a pisos: 

 

1. Seleccionar la superficie. 
2. En la pestaña contextual Modify – Toposolid => panel Shape Editing  => escoger icono 

 
3. Dibujar la línea de división. 

 

 
 

Para agregar nodos: 

 

1. Seleccionar la topografía. 
2. En la pestaña contextual Modify – Toposolid => panel Shape Editing => escoger icono 

 
3. Hacer clic en el sitio donde será colocado el nodo (ya sea en el contorno o área de la 

topografía) 
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Para modificar altura de los nodos: 

 

1. Seleccionar la topografía 
2. En la pestaña contextual Modify – Toposolid => panel Shape Editing => escoger icono 

 (Modify Sub elements). 
3. Seleccionar el nodo al cual requiere cambiar la elevación. 
4. Cambiar el valor actual de elevación. 
5. Si necesita cambiar la elevación de otros nodos realizar el mismo procedimiento. 

 
Para eliminar los cambios realizados en la forma de una topografía: 

 

1. Seleccionar la topografía. 

2. En la pestaña contextual Modify – Toposolid => panel Shape Editing => escoger icono  
(Reset Shape). 
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Capítulo 6  
  
Planos   
  

Son llamadas también hojas de dibujo, las cuales generalmente incluyen un rotulo con 

información acerca del proyecto. Básicamente los planos, son las láminas de impresión 

(Layouts) que incluyen diferentes vistas del proyecto.   

  

  
  

Crear vistas de plano  

  

Contienen los planos del proyecto y se guardan cómo vistas bajo la sección Sheets en el 

navegador de proyectos.   
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Los planos necesitan de un pie de plano para definir el tamaño de hoja para imprimir y 

mostrar la información del proyecto. Las familias de pie de plano están definidas en familias 

cargables de anotación.  

  

Para cargar una familia de plano a un proyecto:  

1. Escoger pestaña Insert => Load from Family => icono  (Load family) 2. 

En las librerías de Revit, buscar  la carpeta Titleblocks.  

3. Seleccionar el archivo de pie de plano a abrir. Las familias de pie de plano vienen 

definidas por tamaños.  

  

  
  

Las familias de pie de plano se pueden editar para ajustar el tamaño de la hoja, los 

datos del rótulo, las etiquetas que mostrarán información del plano y proyecto etc.  

  

Para crear una vista de plano:  

1. Escoger pestaña View => panel Sheet Composition => icono  (Sheet)  

2. En la caja de dialogo New Sheet en la sección Select titeblocks: seleccionar en el 

listado el pie de plano a utilizar.  
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3. Presionar el botón OK.  

  

Los planos contienen una o varias ventanas con información de las vistas del proyecto, 

estas ventanas pueden estar a diferente escala.  

  

Para crear ventanas en una vista de planos:  

  

1. Abrir una vista de plano  

2. Escoger pestaña View => panel Sheet Composition => icono  (Place view)  

3. En el listado de vistas que aparece en la caja de dialogo View, seleccionar la vista a 

colocar en el plano.  
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4. Presionar el botón Add View to Sheet  

5. Hacer clic dentro del área del pie de plano para colocar la vista.  

  

  
  

Nota: para colocar vistas en un plano también, puede seleecionar la vista desde el navador 

de proyectos arrastrar y soltar directamente dentro el área de pie de plano.  

  

Recorte de vistas  
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Permite recortar el contorno de las vistas para ajustar el área de visualización, lo cual es útil 

para optimizar el tamaño de las ventanas que serán colocadas en los planos.  

  

Para mostrar el contorno para recorte:  

  

1. Activar la vista a recortar  

2. En la barra de herramientas de Estatus, hacer clic sobre el icono  (Show Crop 

region).  

3. Se despliega el contorno de la vista en color azul   

  

  
4. Utilizando los nodos de color azul se puede modificar el área de recorte en la vista.  

  

  
  

5. Una vez ajustada la vista, se puede insertar en un plano.  

  

Para activar o desactivar el recorte de vista:  

  

1. En la barra de herramientas de Estatus, hacer clic sobre el icono  (Crop View).  
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Asignar escala a ventanas en vistas de plano  

  

Se pueden colocar varias ventanas en una vista de plano, cada ventana puede configurarse 

a una escala diferente.  

  

Para asignar escala a una ventana en un plano:  

  

1. Activar el plano  

2. Seleccionar la ventana a la cual se asignará la escala.  

3. En la paleta de propiedades en la casilla View Scale seleccionar la escala a asignar.  
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Edición de vistas en el plano  

  

Es posible realizar ajustes básicos de las ventanas sobre los planos.  

  

Para editar vistas desde un plano:  

  

1. Activar la vista de plano  

2. Seleccionar la vista a editar  

3. Escoger pestaña Modify Viewports => panel Viewport =>   (Active View) o 

hacer doble clic sobre la vista.  

4. Puede seleccionar y realizar cualquier tipo de edición sobre los elementos de la vista 

activa, cambiar la escala, estilo visual, ocultar objetos etc.  

  

  
  

5. Para desactivar la vista que está en edición, hacer doble clic en cualquier lado fuera 

del área de la vista activa.  

  

Guide Grids (Cuadrículas)  

  

Las cuadriculas sirven cómo referencia para alinear la ubicación de las vistas.  

  

Agregar una cuadricula sobre el plano:  

  

1. Escoger pestaña View => Panel Sheet Composition => icono   
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2. Asignarle un nombre a la cuadrícula  

3. Seleccionar la cuadricula y ajustarla arrastrando los nodos que están en los 

extremos.  

  

  
  

  

4. En las propiedades de instancia en la casilla Guide Spacing, se puede cambiar el 

tamaño de las celdas.  

5. Arrastrar las ventanas dentro del plano para alinearlas con la cuadrícula.  

  

  
  

  

6.   
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Referencias a Vistas  
  

Una referencia es un símbolo que indica el número de vista y número de plano al cual esta 

referenciada la vista. Las referencias a vistas pueden ser colocadas en cualquier vista 

estándar, excepto listados de cuantificación, planos y perspectivas. En las vistas 3D 

bloqueadas se pueden colocar referencias también.  

  

Los símbolos de referencia se crean o editan como el editor de familias y pueden contener 

líneas, regiones de relleno, textos, etiquetas y además contienen los parámetros que 

indican las referencias a vistas.  

  

NOTA: tomar en cuenta que, para trabajar con referencias a vistas, las vistas a la cual hacen 

referencias deben estar colocadas en un plano. Por ejemplo; si crea una vista de detalle de 

un mueble a partir de una vista de planta; la vista de planta debe existir en una vista de 

plano, porque de lo contrario el símbolo de la referencia no mostrará ningún valor.  

  

Una referencia puede vincularse con más de una vista. Por ejemplo; En la imagen, el detalle 

del área donde está la lámpara puede vincularse con la vista de planta o con la vista de 

sección.  

  

  
  

Para colocar una referencia a vista:  

  

1. Crear o abrir la vista en la cual se va a colocar la referencia  

2. Escoger pestaña View => panel Sheet Composition => icono  (View Reference)  

3. Escoger la pestaña contextual Modify View Rerefence  => panel View Reference 

desplegar las casillas   

  

• View Type: para definir con que tipo de vista estará vinculada la referencia, que 

puede ser, vista de planta, corte, elevación etc.  

• Target View: para definir el nombre de vista con la cual estará vinculada la 

referencia.  
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4. Hacer clic en el sitio donde quedará colocada la referencia  

  

  

Listados de planos  
  

Un listado de planos es una tabla que contiene información que se colocará en el pie de 

plano.  

  

Para crear un listado de planos:  

  

1. Escoger pestaña View => panel Create => desplegar icono  =>  

opción   

2. En el cuadro de dialogo Propiedades de listado de planos activar la pestaña Fields  

3. Seleccionar los campos que se incluirán en el listado.  
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4. En la pestaña Formatting asignar los nombres de las columnas.  

  

  
  

Para añadir datos de planos al listado:  

  

1. Activar la vista del listado de planos  

2. Escoger pestaña Modify Schedule/Quantities => Panel Rows => icono  

   
3. Se añadirá un registro en blanco a la tabla de planos  

4. Llenar los datos para el plano.  

5. Puede agregar cuantos registros necesite de acuerdo con la cantidad de planos que 

se vayan a generar en el proyecto.  

  

  
  

NOTA: Es posible agregar planos adicionales en cualquier momento.  
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Para crear un plano asignando datos del listado de planos:  

  

1. Escoger pestaña View => Panel Sheet Composition => icono   

2. En la caja de dialogo Nuevo Plano escoger el pie de plano a usar  

3. en la sección Select placeholder sheets seleccionar registro con la información del 

plano.  

  

  
  

4. Presionar el botón OK  

  

Edición de títulos de ventanas en planos  

  

Los títulos de las ventanas que se colocan en los planos están definidos en familias 

cargables y son anotaciones que pueden editarse en contenido.  

  

Para editar una familia de título de ventana:  

  

1. Seleccionar el título y en la paleta de propiedades en el selector de tipos se podrá 

observar el nombre de la familia a la cual pertenece.  
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2. Escoger Menú File => Open => Family  

3. En la carpeta Annotations, buscar los archivos de familias cuyo nombre comience 

con las letras M_Title*, escoger el archivo de familia a editar y abrirlo.  

  

    
  

Para añadir una etiqueta:  

4. En el editor de familias Escoger pestaña Create => panel Text => icono  (Label)  

5. En la vista, hacer clic en el sitio donde se quiere colocar la etiqueta   

6. En el listado de campos disponibles seleccionar la etiqueta requerida y hacer doble 

clic para agregarla en la sección Label Parameters.  

  

   
7. Una vez colocada la etiqueta pueda ajustar el estilo y tamaño del texto desde las 

propiedades de tipo.  

8. Guardar los cambios y cargar la etiqueta al proyecto.  

  

Para asignar un título a una vista de plano:  

  

1. Cargar al proyecto la familia del título a asignar  

2. Abrir la vista de plano   

3. Seleccionar el título de ventana a cambiar  

4. En la paleta de propiedades, entrar a las propiedades de tipo y bajo del grupo de 

parámetros Graphics, desplegar la casilla que esta frente a la opción Title.  
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Nube de revisión  
  

Permiten colocar observaciones, números de revisión o cambios sobre los planos. Para 

llevar un control correcto sobre las revisiones es necesario crear un listado con datos de 

revisión ya sea por plano o por proyecto.  

  

Configurar el reporte de revisión  

  

Para registrar las revisiones en los planos es necesario crear una tabla para de revisiones 

en la familia de pie de planos.  

  

Para crear un listado de planos con datos para revisión:  

  

1. En el editor de familias, abrir el archivo de familia de pie de plano a utilizar para los 

planos del proyecto.  

2. En el editor de familias, Escoger pestaña View => panel Create =>  

(Revision Schedule).  

3. Escoger los campos que incluirá el listado.  

   
4. Arrastrar el listado de revisión sobre el pie de plano y colocarlo dentro del área de 

impresión.  
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5. Guardar los cambios en la familia de pie de plano y cargarla al proyecto, sobre 

escribir la familia si es necesario.  

  

Registros de revisión  

  

Los datos de las revisiones deben ser registrados en la caja de dialogo de revisiones, previo 

a ser colocados en el plano con la información de número de revisión, descripción, fecha, 

responsables.  

  

1. Abrir la vista de plano en la cual se van a registrar las observaciones para revisión  

2. Escoger pestaña View => panel Sheet Composition => icono  (Sheet  

Issues/Revisions)  

3. En la sección Numering escoger la opción requerida según cómo se vayan a registrar 

las observaciones ya sea por plano o por proyecto  

  

   
4. En la sección Numerign options, se configuran las opciones para numerar las 

observaciones.  
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5. Presionar el botón Add, para añadir los datos para una nueva observación 

espeficiando, fecha, descripción, quíen asigna, quien debe corregir.   

  

  
  

Bajo la columa Show, las opciones Cloud and Tag, indican que las observaciones 

aparecerán en el plano con una marca de nube acompañada de un tag.  

  

6. Presionar el botón Ok, para dejar registradas las observaciones.  

  

Para colocar una nube de revisión sobre el plano:  

  

1. Activar la vista de plano en la cual se requiere colocar las revisiones  

2. Escoge pestaña => Insert => panel Detail => icono  (Revision  

Cloud)  

3. Utilizando las herramientas del panel Draw dibujar una nube de revisión sobre el 

área o elementos del plano requeridos.  

  

  
  

4. Presionar el botón  (Finish Edit Mode) para crear la nube de revisión  
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5. Los datos de revisión asignados a la nube se pueden observar en las propiedades 

de instancia y en la tabla de revisiones.  

  

  
  

  

Para mostrar tag en el plano con número de revisión:  

  

1. Abrir la vista de plano que contenga datos de revisión  

2. Escoger pestaña Annnotate => panel Tag => Tag By Category  

3. HAcer clic sobre la nube de revisión, colocar el tag en la ubicación requerida.  
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Capítulo 7  
  

Impresión y publicación  
  
Puede imprimir a archivos digitales en formatos PDF, DWG o DWF los cuales pueden 

contener una o varias vistas del proyecto en un mismo archivo. Los archivos DWF pueden 

visualizarse en la plataforma de nube BIM 360.   

  

Exportar a formatos DWF  

  

Los archivos DWF pueden contener una o varias vistas del proyecto en un mismo archivo, 

se puede abrir localmente con la aplicación gratuita Design Review o subirlos a la 

plataforma de nube BIM 360 para visualizarlos.  

  

Para exportar a formatos DWF:  

  

1. Escoger pestaña File => Export =>   

2. Presionar el botón  (New Set) para crear un set de impresión que incluya varios 

planos o vistas.  

  

  
  

3. Asignar un nombre al set  
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4. En el listado, seleccionar las vistas o planos a exportar al DWF  

  

  
  

Los archivos DWF generados por Revit, se visualizan con el programa Desing Review, a 

los planos se les puede colocar marcas de revisión que luego podrán ser cargadas en las 

vistas de plano en Revit.  

  

NOTA: Las marcas de revisión en Design Review, se deben colocar sobre planos (sheets)  

  

Para cargar las marcas de revisión en Revit:  

  

1. Escoger Pestaña Insert => Panel Link =>   

2. Seleccionar el archivo DWF a cargar.  

3. En el listado seleccionar la vista de plano a cargar  

4. Las marcas de revisión creadas en Design Review serán cargadas en la vista de 

plano  
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Para controlar la visualización de marcas de revisión en los planos:   

  

1. Activar el cuadro de dialogo Visibility/Graphics  

2. Activar la pestaña Imported Categories  

  

  
  

3. En el listado de marcas de revisión desactivar o activar la visualización.  

4. Presionar el botón OK.  

  

Para controlar el estado de una marca de revisión:  

  

1. Activar la vista de plano  

2. Seleccionar la marca de revisión  

3. En las propiedades de instancia, bajo los parámetros Identity Data, podrá cambiar el 

estado, agregar notas y revisar el historial  
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Para eliminar el vínculo de un archivo DWF con el proyecto:  

  

1. Escoger pestaña Insert => panel Link => icono  (Manage Links)  

2. Activar la pestaña DWF Markups  

  

   
3. Presionar el botón Remove.  

4. Presionar el botón Ok para salir del cuadro de dialogo.  

  

Exportación de vistas a formatos DWG  

  

Revit permite exportar tanto vistas 2D como 3D a otros formatos de dibujo, cómo AutoCAD.  

  

Para exportar información desde Revit a formatos DWG  

  

1. Escoger pestaña File => Export => CAD Formats => opción DWG.  

2. En la caja de dialogo DWG Export, en la sección Select Export Setup, hacer clic  

sobre el botón  (Modify export setup).  

3. Para crear un formato de exportación, hacer clic sobre el icono  (New Export 

Setup)  

4. En la pestaña Layers, bajo la columna Category se muestra el listado de todas las 

categorías existentes en Revit.  

5. Bajo la columna Layer, se muestra el nombre de la capa en la cual se colocarán los 

objetos de acuerdo con su categoría. Se puede modificar el nombre del layer y el 

color.  
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6. En la pestaña Solids, escoger si los objetos se exportan como sólidos o mallas. Esta 

opción aplica sobre las vistas 3D  

  

  
7. En la pestaña Units & Coordinates, escoger las unidades de medida para 

exportación.  

  

  
  

8. Presionar el botón Ok para salir del cuadro de dialogo de formatos de exportación.  

9. En la sección Select Export Setup seleccionar el formato de exportación 

correspondiente.  
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10. En el cuadro de dialogo DWG Export y presionar el botón Siguiente.  

11. En la casilla Tipo de archivo, escoger la versión de AutoCAD en la cual se quiere 

guardar el archivo.  

12. Cuando la opción Export views on sheets and links as external references esta 

activa, en AutoCAD las vistas se colocan sobre layouts y el dibujo (del entorno 

modelo) queda ligado como una referencia externa.  

  

   
Impresión  

  

Revit permite al usuario imprimir diferentes elementos de una vista como la ventana actual, 

una porción visible de la ventana actual, o las vistas seleccionadas, incluyendo planos.  Lo 

que se ve en pantalla es lo que se imprime, aunque hay algunas excepciones como:    

  

• Sin importar el color de fondo en la pantalla, el color del fondo en el trabajo de 

impresión es siempre blanco.   

   

• Por defecto, los planos de referencia, los planos del trabajo, los límites de las líneas 

de corte y las cajas del alcance no imprimen, incluso si están visibles en la vista.  A 

menos que se active la impresión de estas en las opciones de la caja de dialogo de 

impresión.    

  

• Los objetos que se hayan ocultado o aislado con el comando Temporary  

Hide/Isolate si se imprimen  

  

Revit no requiere controladores especiales para los dispositivos de salida, basta con tener 

las impresoras o plotters instalados en el sistema operativo para puedan ser reconocidos 

por el programa.  

  

Para imprimir vistas desde Revit:  

  

1. Escoger pestaña File => Print => Print  
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2. En la casilla Name: se debe escoger el nombre de la impresora.  

  

Desde este cuadro de dialogo se puede imprimir a formato PDF, escogiendo la 

opción en la casilla Name:  

  

3. En caso de que se requiera imprimir varias vistas o planos, activar la opción 

Selected Views/sheets  

4. Hacer clic en el botón Select.  

5. En el listado de vistas, escoger los planos o vistas a imprimir.  

6. En la sección Settings hacer clic sobre el botón Setup…  

7. En la sección Zoom, activar la opción Zoom con valor de 100 %  

  

  
  

Al escoger las opciones indicadas todas las vistas se imprimen de acuerdo con la 

escala que tienen configuradas enRevit.  
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8. Presionar el botón Ok.   

En caso de que la impresión esté configurada para generar un archivo PDF, se debe 

ingresar el nombre del archivo.  

  

  

  

  
  

  


